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Highlights 

 Hand-drawing effect 
 One-click drop shadows 
 Translucent raster images, bitmap textures, and gradient fills 
 Smooth blending of raster images into the background (8-bit alpha channels) 
 Improved rendering quality and more powerful handling of translucency effects 
 Faster, higher-quality bitmap exporting 
 50% smaller PDF files and support for PDF 1.5, including layer data 
 Other improvements 

Hand-drawing effect 
A hand-drawn look adds a touch of personality to your drawings. You can use different effects 
(curve, deviate, move ends, break and vary width, multiple line segments) to make the drawing 
look like it was hand-drawn. This is an excellent feature for use in casting initial sketches from 
your designs, for example. 

One-click drop shadows 

Adding drop shadows to text or graphics gives depth and flair to your layout. You can create drop 
shadows simply with the click of a button, then easily adjust the angle, distance, and feathering of 
the shadow. 

Translucent raster images, bitmap textures, and gradient fills 

You can make raster images partially transparent so that the background still shows through. You 
can use the same effect also for bitmap texture fillings and gradient fills. For example, imagine the 
possibilities of a gradient fill transitioning gradually towards transparency. 

Smooth blending of raster images into the background (8-bit alpha channels) 
All transparent raster images are now smoothly blended into the background. With the new 8-bit 
alpha channel support you can add photos of trees, people, etc. that blend into your drawing 
perfectly. 

Improved rendering quality and more powerful handling of translucency effects 

The rendering mechanism of M-Color has been completely renewed; as a result, the on-screen 
graphics are smooth and exact. Also, the previewing responds much more rapidly than before, 
especially when you have used translucent effects. 

Faster, higher-quality bitmap exporting 

The new technology of M-Color 9 enables you to export your drawing as a raster image in just a 
fraction of the time used by previous versions of M-Color. In addition, the quality of the resulting 
image is enhanced. 

 

C H A P T E R  1  

What's New in M-Color 9 



 

4 M-Color 9 User's Guide 
 

50% smaller PDF files and support for PDF 1.5, including layer data 

With M-Color 9, you can generate small, high-quality PDF files. M-Color 9 also supports PDF 
1.5, including inclusion of your CFG layer information in the resulting PDF file. 

Other improvements 

M-Color 9 supports hyperlinks in PDF files. Also, you can now also save CFG and PAL files into 
old formats and activate your M-Color license instantly online. Another improvement providing 
flexibility is the integration with the AutoCAD paper frame in Paper Space. 

For automated usage of the software, APIs for bitmap exporting and CFG and PAL manipulation 
are included in the program. 
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This chapter gives you instructions on how to install M-Color on your computer. 
 

Planning the Installation 

Single Computer vs. Network Installation 
Single computer installation means installing M-Color on a single computer. The computer may or 
may not be connected to a network, but M-Color is installed to be used only on that computer. If 
you install a single computer license of M-Color on several computers, each computer will be 
running M-Color independently of each other and you must purchase a separate single computer 
license for each computer. 

See Making a Single Computer Installation for instructions on installing M-Color on a single 
computer. 

Network installation means installing M-Color on several computers on the network and using a 
network license. To make a network installation, you must purchase a network license of M-Color. 
In a network installation, you can install M-Color on any number of computers on the network. Up 
to the specified number of users will be able to use M-Color concurrently. The M-Color License 
Server will track M-Color usage on the network and make sure license rights are not being 
violated. 

See Making a Network Installation for instructions on installing M-Color on a network. 

See Single Computer License and Network License for more information about different license 
modes. 
 

Making a Single Computer Installation 
To install M-Color on a standalone computer or computers, you should run M-Color Setup 
independently on each computer. 

Do not install the M-Color License Server component on any of the computers. 

See Running M-Color Setup for more information. 
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Making a Network Installation 
In a network installation, one computer needs to function as the M-Color License Server. The 
computer may or may not have M-Color installed on it. All computers on the network which will 
be running M-Color must have a TCP/IP network access to the License Server computer. The 
network server is a natural choice for the License Server, but any other computer may be used as 
well. 

Once you have decided which computer will function as the M-Color License Server, run M-Color 
Setup on that computer. Install the M-Color License Server component on this "server" computer. 

Install M-Color on any number of other computers on the network by running M-Color Setup on 
each of them. Do not install the M-Color License Server component on these "client" computers. 

See Running M-Color Setup for more information. 
 

Running M-Color Setup 

System Requirements 
Hardware requirements: 

 Computer capable of running Windows and AutoCAD / AutoCAD LT. 
 No additional requirements. 

Software requirements: 

 Windows Vista/XP/2000 
 AutoCAD 2009/2008/2007/2006/2005/2004/2002/2000i/2000 or AutoCAD LT 

2009/2008/2007/2006/2005/2004/2002 (AutoCAD is not required if you only intend to run M-Color 
Preview) 

 

Starting M-Color Setup 
To install M-Color on your computer, you need to run the M-Color Setup program. 

To run M-Color Setup from CD-ROM: 

1 Insert the CD-ROM in the CD drive. 

2 Wait for M-Color Setup to start automatically. 

3 If M-Color Setup does not start automatically, run Setup.exe in the Setup folder on the CD-
ROM. 

To run M-Color Setup from the packaged file obtained from the Internet: 

1 You should have obtained a file named M-Color.exe from the Internet. 

2 Run the M-Color.exe file by double-clicking it in Windows. 
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Choosing Language 
M-Color Setup asks you to specify the installation language. This selection will affect the dialog 
boxes and messages that appear during the installation, and it will also determine the language of 
the dialog boxes and messages of the M-Color software itself. 

To choose the setup language: 

1 Select the language from the dialog box. 

2 Click OK to proceed with installation. 
 

Welcome Screen 
M-Color Setup shows the Welcome dialog box. 

Click Next > to proceed with installation. 
 

License Agreement 
M-Color Setup shows the License Agreement for M-Color. Read the agreement carefully before 
proceeding. 

If you accept all of the terms and conditions in the agreement, you can click Yes to proceed with 
installation. 

If you do not accept all of the terms in the agreement, you must click No and close the setup. 
 

Choosing Destination Location 
M-Color Setup shows the Choose Destination Location dialog box. In general, you should install 
M-Color to the default destination location. 

To change the destination location: 

1 Click Browse. 

2 Type the name of the destination folder. 

3 Click OK to accept the folder. 

Click Next > to proceed with installation. 
 

Selecting Components 
M-Color Setup shows the Select Components dialog box. 

If you are installing M-Color to a standalone computer, or to a client computer on a network, you 
should install the M-Color component but not the M-Color License Server component. 

Install the M-Color License Server component only if you have purchased a network license and 
you want to make this computer the license server on the network. Install the M-Color License 
Server component on only one computer on the network. 

Click Next > to proceed with installation. 
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The Welcome to M-Color Dialog Box 
M-Color Setup shows the Welcome to M-Color dialog box and asks you whether you want to use 
M-Color in full mode or in evaluation mode. 

If you have not yet purchased a license and want to evaluate M-Color: 

1 Select Evaluation mode and click Next >. 

If you have already purchased a license: 

1 Select Full mode and click Next >. 

2 Depending on your license type, select Single computer license or Network license and click 
Next >. 

Single computer license: 

1 If you have already obtained your M-Color License Code, type the license code in the edit box 
and click Next >. 

2 If you have not yet obtained your M-Color License Code, select I want to obtain the license 
code now and click Next >. The Request License Code Wizard appears and guides you through 
the process of requesting your M-Color License Code. 

Network license: 

1 Specify the type of this computer by selecting Client or License server and click Next >. 

2 In the case of a client computer, M-Color will look for a valid license on the network. In the 
case of a license server computer, you are prompted to type your network license code or fill 
in the License Code Request. 

 Client computers obtain the license from the license server computer via the network. The 
license server computer grants licenses to other computers on the network. The license server itself 
can also run M-Color. There should be only one M-Color license server on your network, and it 
must have the M-Color License Server software component installed on it. 
 

Finishing Setup 
M-Color Setup shows the Setup Complete dialog box. 

Make sure that the View M-Color Flash presentations box is checked. M-Color Flash presentations 
will give you a quick start in M-Color. 

Click Finish to complete setup. 
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License Code 

What is a license code? 
The M-Color License Code is a digital code which captures your license rights in electronic form. 

This is an example of an M-Color License Code: 

AA89 5J4Z ZYW5 4YOV 

(Note: This code will not work on your system.) 

Before you can run M-Color in full mode, you need to enter your license code. The license code 
tells M-Color important information about your license rights, including 

 the license mode (single computer or network license) 
 the computer(s) on which M-Color can be used 
 the permitted number of concurrent users on the network 

To obtain your license code, you need to purchase M-Color and fill in the License Code Request. 
See Using the Activate Licence Wizard for more information. 

See Single Computer License and Network License for more information about different license 
modes. 
 

Single Computer License 
A single computer license permits you to install and use M-Color on one computer. 

A single computer license code locks the license to a specific computer, preventing you from 
running M-Color on other computers. The license is locked to a "computer fingerprint", which is 
different in each computer. 
 

Network License 
A network license permits you to install M-Color on any number of computers on the network. 
Only the number of concurrent users of M-Color is limited. For example, if you have purchased 
five concurrent user licenses, then up to 5 users may use M-Color at the same time. 

One computer on the network will function as the M-Color License Server. When a user starts M-
Color on a client computer on the network, M-Color communicates with the License Server 
computer to see if a license is available. If there is a license available, M-Color will start. If all 
licenses are already in use, M-Color will not start until some other user stops using M-Color. 
 

Using the Activate Licence Wizard 
In order to use M-Color, you need to activate your license. The Activate Licence Wizard will 
guide you through the process of filling in the request. 

To fill in the License Code Request: 

1 In Windows, click Start. 
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2 On the Start menu, select Programs, M-Color, License Management and click the Acticate 
License icon. 

3 The Activate License Wizard appears. 

4 Follow the instructions of the wizard and fill in the required information. 

5 Click Next > to move to the next pages in the License Code Request. 

6 Once you have filled in all the required information, you can select to activate your license 
over the Internet or by e-mail or fax. The instant Internet activation is the preferred method. If 
Internet activation is not available, use e-mail or fax. 

7 Click Finish on the last page. 

If you have selected to activate your license by e-mail or fax: 

The License Code Request is a standard text file which you can e-mail, fax or print and send to 
your M-Color reseller. 

The preferred method is to use e-mail. This ensures the fast and accurate processing of your 
license code request and eliminates misunderstandings. 

To send the License Code Request by e-mail: 

1 Start your e-mail application. 

2 Start a new message. Enter the e-mail address of your reseller in the To field. If you have 
purchased M-Color directly from Motive Systems, enter support@m-color.com in the To field. 

3 Switch back to the License Code Request in Notepad. Copy the data onto the clipboard as 
follows: 

Click Select All on the Edit menu. 

Click Copy on the Edit menu 

Switch back to your e-mail application. 

Paste the data to the e-mail message by clicking Paste on the Edit menu. 

4 Send the e-mail message. 
 

Getting a Replacement Code 
When updating your computer equipment or when changing computers which need to be able to 
run M-Color, you may find out that you need to activate your M-Color license again. 

To activate your license, see Using the Activate Licence Wizard for more information. 

Note that after installing M-Color on the new computer, you may no longer use M-Color on the 
old system. You must completely remove the software from the old computer. To use M-Color on 
both computers, you need to purchase an additional license of M-Color. 
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License Management Operations 

Welcome Screen 
The Welcome to M-Color screen is displayed at the end of M-Color Setup and every time you start 
M-Color if you have not yet activated your license. 

Select Full mode if you own a license to use M-Color and you want to activate this license. 

Select Evaluation mode if you have not yet purchased a license and want to evaluate M-Color prior 
to purchasing. You can use M-Color in evaluation mode for 14 days and only for evaluation 
purposes. After this evaluation period, you may only use M-Color if you purchase a license. 

Click Next to proceed. 
 

Activating a License 
To activate your M-Color license, start the Activate License Wizard: 

1 In Windows, click Start. 
2 On the Start menu, select Programs, M-Color, License Management and click the Activate 

License icon. 

3 The Activate License Wizard appears. 

Select the type of license you have purchased. You should only use the Activate License command 
if you have already purchased a license for M-Color. 

Select Single computer license if you have purchased a single computer license that allows you to 
install and use M-Color on a single computer. 

Select Network license if you have purchased a network license that allows you to install M-Color 
on any number of computers and to use the M-Color License Server component to monitor 
concurrent use of M-Color. 

Click Next to proceed. 
 

Activating a Single Computer License 
In order to activate your single computer license for M-Color, you need a License Code. 

If you do not have a License Code, select I want to obtain the license code now and click Next. This 
will take you to the Request License Code wizard. 

You may have received a temporary license code at the time you purchased M-Color. If so, you 
can activate your single computer license by entering the temporary license code in the provided 
space. Note that you must then fill in a License Code Request in order to receive your permanent 
License Code that locks M-Color to this computer. If you do not fill in the License Code Request 
and send it to the company you purchased M-Color from, M-Color will stop functioning when the 
temporary license code expires (usually in a couple of weeks). 
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If you have already received your permanent license code, enter it in the provided space and click 
Next. M-Color should display a message saying that the license was successfully activated. If not, 
make sure that you entered the license code correctly and that the license code has been generated 
for exactly the same computer fingerprint as displayed on screen. 
 

Activating a Network License 
In a network license configuration, one of the computers on your network needs to function as the 
license server. Typically, you should use your network server for this purpose. 

When activating a network license, you need to tell M-Color whether you are activating the license 
on a client computer or on the license server computer. 

Select Client or License server and click Next to proceed. 
 

Activating the License Server Computer 
Before you can activate the network license on any client computers, you must activate the 
network license on the license server computer. 

In order to activate your network license for M-Color, you need a License Code. 

If you do not have a License Code, select I want to obtain the license code now and click Next. This 
will take you to the Request License Code wizard. 

If you have already received your network license code, enter it in the provided space and click 
Next. M-Color should display a message saying that the license was successfully activated. If not, 
make sure that you entered the license code correctly and that the license code has been generated 
for exactly the same computer fingerprint as displayed on screen. 
 

Activating a Client Computer: Automatic Search for the License Server 
When you are activating a network license on a client computer, M-Color will first try to 
automatically locate the license server computer on your network. 

M-Color will send a broadcast message (UDP protocol, port 5093) to the local IP subnet and wait 
for responses from any license servers that may exist on the local subnet. If a license server is 
found and it can grant a valid license, M-Color will use that license server. 

If there is no license server on the local IP subnet, the automatic search will not be able to find a 
license server. In this case, M-Color will display an error message and you can then tell M-Color 
the DNS name or IP address of the license server computer you want to use. 

Click Next to start the automatic search. 
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Activating a Client Computer: Specifying the License Server Computer 
If there is no license server on the local IP subnet, the automatic search will not be able to find a 
license server. In this case, M-Color will display an error message and you can then tell M-Color 
the DNS name or IP address of the license server computer you want to use. 

Type the DNS name or IP address of the license server in the provided space and click Next. 
If M-Color is still unable to find the license server, please ensure that the computer you have 
specified is in fact running the M-Color License Server component and that you have activated the 
network license on that server. Also, check TCP/IP communication between the client computer 
and the license server. 

M-Color communicates with the license server by using the UDP protocol and port number 5093. 
 

Requesting License Code 
See Using the Activate Licence Wizard. 
 

License Status 
To view the status information about your M-Color license: 

1 In Windows, click Start. 
2 Select Programs, M-Color, License Management and click the License Status icon. 

3 The License Status dialog box appears. 

See License Status for more information on how to interpret the information in the License Status 
dialog box. 
 

What is a portable license? 
A portable license is a license you can temporarily check out from the network and take with you 
on a business trip, for example. 

You must own a network license for M-Color in order to use the portable license features. 

Reserving a license for laptop use is called checking out a portable license. Returning a license 
from the laptop back to the network is called checking in a portable license. 

See the following chapters for instructions on how to check out and check in a portable license. 
 

Checking Out a Portable License 
Reserving a license for laptop use is called checking out a portable license. 

In order to check out a portable license for use on your computer, you must be connected to the 
network. After checking out a portable license to this computer, you can disconnect from the 
network and still use M-Color. 

To check out a portable license to this computer: 

1 Ensure that AutoCAD and M-Color Preview are not running. 
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2 In Windows, click Start. 
3 Select Programs, M-Color, License Management and click the Portable License Check-Out / 

Check-In icon. 

4 The Portable License Check-Out window appears. 

You need to type the number of days you want the checked-out license to be valid. This is to 
protect your licenses from being “lost”. If something happens to your laptop computer while you 
are traveling and you are unable to check in the portable license back to the network, the license 
will be automatically freed on the network after the number of days you specified has expired. 

To check out a portable license, click Check Out. 
 

Checking In a Portable License 
Returning a laptop license back to the network is called checking in a portable license. 

In order to check in a portable license back to the network, you must have previously checked out 
a portable license to this computer. 

To check in a portable license from this computer back to the network: 

1 Ensure that AutoCAD and M-Color Preview are not running. 

2 In Windows, click Start. 
3 Select Programs, M-Color, License Management and click the Portable License Check-Out / 

Check-In icon. 

4 The Portable License Check-In window appears. 

You do not need to type the name or IP address of the license server if the license server is on the 
same subnet as this computer. 

To check in the portable license back to the network, click Check In. 
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M-Color Flash presentations will give you a quick start in M-Color. Point your browser to 
http://www.m-color.com/viewflash to view tutorials on M-Color. 
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This chapter gives you step by step instructions on how to perform specific tasks in M-Color. 

Understanding Plot Appearance Settings (CFG 
Files) in M-Color 

The Principles of Plot Appearance Settings (CFG Files) 
In M-Color, the Plot Appearance (CFG) dialog box is the key tool in controlling the plotting 
appearance of the objects in your drawing. Plot appearance settings are saved to so called CFG 
files. 

You can think of the AutoCAD drawing as the “geometry”, and the CFG file as the “visualization 
settings”. Understanding this division allows you to make your work more productive. You can 
use the same geometry (AutoCAD drawing) to produce multiple plots with different visual aspects 
by using a different CFG file for each plot. Or, you can reuse the visual aspects defined in a single 
CFG file to plot multiple AutoCAD drawings. 

CFG Layers 

A key concept in modifying plot appearance settings is CFG layer. A CFG layer groups together 
AutoCAD objects that have similar properties in AutoCAD (such as layer and/or object color). 
You can assign various effects to CFG layers: you can control the fill style, outline width and 
outline style of CFG layers. 

Layer Name Condition and Color Index Condition 

To take full advantage of the possibilities of M-Color, you must understand how M-Color selects 
the objects for which it applies visualization settings. Each CFG layer in the CFG file has two 
condition fields: layer name condition and color index condition. Together, these conditions define 
the criteria that AutoCAD objects must match in order to follow the appearance settings defined 
for this CFG layer. 

For example, if the layer name condition of a CFG layer is A-WALL* and the color index condition 
is Any, the CFG layer's appearance settings will apply to all AutoCAD objects on layers whose 
name begins with A-WALL. 

If the layer name condition of a CFG layer is * and the color index condition is Blue (5), the CFG 
layer's appearance settings will be applied to all blue AutoCAD objects, regardless of their layer. 

It is possible to use both of these conditions, for example to control the appearance of red 
AutoCAD objects on layer A-WALL-MAIN. 

Appearance Settings 

Each CFG layer has several visualization settings that define the appearance of the objects 
controlled by that CFG layer. These settings are fill style, outline width, outline style and on/off 
state. By modifying these settings, you can change the way objects look in your plot. 

C H A P T E R  4  
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In addition to simple solid colors, M-Color lets you define effects such as gradient fills, translucent 
fills and bitmap textures for CFG layers. Using these effects is just as simple as selecting solid 
colors for the CFG layer. 

You can also add different effects to the layers. For example a hand-drawn look adds a touch of 
personality to your drawings by making them look like hand-drawn. Adding drop shadows to text 
or graphics gives depth and flair to your layout. 
 

The Plotting Order of Objects 
The CFG file also controls the plotting order of objects: M-Color displays the CFG layers in the 
same order as they appear in the CFG file. The CFG layer at the bottom of the list is displayed 
first, and becomes the bottommost layer in the plot. The CFG layer at the top of the CFG file is 
displayed last, and thus becomes the topmost layer in the plot. 

In the Plot Appearance (CFG) dialog box, you can change the plotting order by simply dragging 
CFG layers to different positions in the list. 
 

Creating a Drawing 

Starting a New Drawing 
M-Color can plot any drawing created by AutoCAD. Thus, starting a new drawing is the same as 
creating a new drawing in AutoCAD. 

To start a new drawing in AutoCAD, click the New command on the File menu. 

 You can use M-Color to plot your existing AutoCAD drawings. You do not need to create 
the drawing specifically for M-Color. 
 

Using an Existing Drawing 
You can plot any existing AutoCAD drawing with M-Color. 

Open the drawing in AutoCAD by clicking the Open command on the File menu. 
 

Adding Drawing Objects 
Use AutoCAD's commands such as LINE, PLINE, CIRCLE and TEXT to add drawing elements 
to your drawing. You do not need to use any special M-Color commands because M-Color can 
plot all AutoCAD objects that you add to your drawing. 
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Adding Solid Color Fills 
To add solid color fills to your AutoCAD drawing, draw them as polyline objects in AutoCAD 
(using the PLINE command, for instance). You need to bound the color fill area using a single 
polyline object: bounding an area with separate LINE segments will not allow M-Color to fill the 
area. The polyline does not need to be explicitly closed using the Close command in AutoCAD 
because M-Color will automatically close any open polylines that have a fill style defined for their 
layer. 

To specify that you want the polyline to be filled with a solid color when plotting, use the Plot 
Appearance (CFG) dialog box in M-Color and define a CFG layer that applies a solid fill style to 
the objects on the polyline's layer. See Working with Plot Appearance Configurations (CFG 
Files) for more information. 

 Because the object's AutoCAD layer typically defines its fill style, you should place areas 
that you want to fill with different styles on different layers in AutoCAD. 

M-Color also fills any other AutoCAD objects that define a fillable area if a fill style has been 
defined for the object through some CFG layer in M-Color. This includes 3DFACEs, CIRCLEs, 
ELLIPSEs, REGIONs and SPLINEs. The filling of ARCs is off by default, but can be turned on 
by clicking Settings on the M-Color menu in AutoCAD. 

Example: To add a color-filled area representing a lake, draw one or more polylines in 
AutoCAD and place them on a layer called LAKE. Then define a fill style such as Blue (sky) to 
the LAKE layer in M-Color's Plot Appearance (CFG) dialog box. 

Adding Translucent Color Fills 
In addition to solid color fills, you can add translucent color fills to your drawing. An object that is 
filled with a translucent color is like a piece of colored glass: you can see other objects through it, 
but the colors of those objects will change depending on the color tone and transparency level of 
the translucent fill. 

You can place translucent fills on top of any objects, including raster images such as scanned 
photos or aerial imagery. 

You add translucent color fills just like solid color fills. Draw the areas you want to be filled as 
polylines, for example, and place them on a specific layer in AutoCAD. Then use the Plot 
Appearance (CFG) command of M-Color to assign a translucent fill style to that layer. See 
Working with Plot Appearance Configurations (CFG Files) for more information. 

 In general, you want to place translucent fills on top of other objects so that there is 
something to see through the translucent fill. This means that in the Plot Appearance (CFG) dialog 
box in M-Color, you should move the layer that contains the translucent fills above the layers that 
you want to see through the translucent fill. 

 Because the object's AutoCAD layer typically defines its fill style, you should place areas 
that you want to fill with different styles on different layers in AutoCAD. 

Example: To add a translucent blue area, draw one or more polylines in AutoCAD and 
place them on a layer called GLASS_WINDOWS. Then define a fill style such as Tl: Glass to the 
GLASS_WINDOWS layer in M-Color's Plot Appearance (CFG) dialog box. 
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Adding Gradient Fills 
You can also add gradient fills to your drawing. A gradient fill is a fill that gradually changes from 
one color to another. The gradient fill can be linear, radial or adaptive, and you can adjust various 
properties like the angle of the fill. You can also change the transparency of the colors in the 
gradient fill. 

You add gradient fills just like solid color fills. Draw the areas you want to be filled as polylines, 
for example, and place them on a specific layer in AutoCAD. Then use the Plot Appearance (CFG) 
command of M-Color to assign a gradient fill style to that layer. See Working with Plot 
Appearance Configurations (CFG Files) for more information. 

 Because the object's AutoCAD layer typically defines its fill style, you should place areas 
that you want to fill with different styles on different layers in AutoCAD. 

Example: To add an area with a fill that changes from white to blue, draw a polyline in 
AutoCAD and place it on a layer called SKY_BACKGROUND. Then define a fill style such as 
Gr: Sky (linear) to the SKY_BACKGROUND layer in M-Color's Plot Appearance (CFG) dialog 
box. 
 

Adding Bitmap Texture Fills 
You can also add bitmap texture fills to your drawing. A bitmap texture fill is a fill that consists of 
a repeating bitmap pattern or a single bitmap that is stretched to fit the object that is being filled. 

M-Color comes with some readily defined bitmap texture fills, and you can define your own 
bitmap texture fills by using any valid image files. 

You add bitmap texture fills just like solid color fills. You can also change the transparency of the 
texturing. Draw the areas you want to be filled as polylines, for example, and place them on a 
specific layer in AutoCAD. Then use the Plot Appearance (CFG) command of M-Color to assign a 
bitmap texture fill style to that layer. See Working with Plot Appearance Configurations (CFG 
Files) for more information. 

 Because the object's AutoCAD layer typically defines its fill style, you should place areas 
that you want to fill with different styles on different layers in AutoCAD. 

Example: To add areas with a repeating brick pattern, draw one or more polylines in 
AutoCAD and place them on a layer called WALL_BRICK. Then define a fill style such as Tx: 
Bricks (red)  to the WALL_BRICK layer in M-Color's Plot Appearance (CFG) dialog box. 
 

Adding High-Quality Text 
To add text to your drawing, simply add text objects to your AutoCAD drawing using the normal 
AutoCAD commands (TEXT and MTEXT, for example). 

You can use any SHX or TrueType fonts when adding text in AutoCAD. M-Color supports all 
these fonts. 

M-Color enhances text quality by automatically replacing standard AutoCAD SHX fonts with 
high-quality TrueType or Adobe Type 1 fonts. 

For more information about text and fonts, see Working with Text and Fonts. 
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Adding Raster Images 
You can add scanned maps, scanned photos or any other raster images to your drawing. M-Color 
will automatically plot all raster images that have been added to the AutoCAD drawing.  

You can use both monochrome (black and white) and color images. Monochrome images will plot 
with the color that is specified as the outline style for their CFG layer in M-Color. Color images 
will naturally plot using their own color definitions. You can make the background of raster 
images transparent in M-Color. You can also make the entire raster image partially transparent so 
that the background still shows through. See Working with Raster Images for more information. 

You can add raster images in AutoCAD by using the IMAGEATTACH command. M-Color can 
also plot images added by any 3rd-party raster application if it conforms to the AutoCAD R14 
IMAGE standard. This includes Autodesk Raster Design (formerly CAD Overlay), GTXRaster 
CAD, Hitachi, Rasterex, Tessel CADRaster and most other raster applications. 
 

Defining Line Colors 
Also the objects' line color is defined using CFG layers in M-Color. Use the Plot Appearance 
(CFG) dialog box to control the outline style of objects. See Working with Plot Appearance 
Configurations (CFG Files) for more information. 

Typically, the outline style is a solid color. However, it is also possible to define a translucent 
style, gradient style or bitmap texture style as the outline style for a CFG layer. This is especially 
useful when working with text because the text objects are filled by using the outline style of the 
layer. For example, you can make a title text object that is filled with a bitmap texture by assigning 
a bitmap texture style as the outline style for the text object's layer. 

 Because the object's AutoCAD layer typically defines its outline style, you should place 
objects that you want to have different outline styles on different layers in AutoCAD. 
 

Defining Line Widths 
Just like other plot appearance settings, line widths are also controlled by CFG layers in M-Color. 
Use the Plot Appearance (CFG) dialog box to define line widths to AutoCAD objects according to 
their layer name, object color, or both. See Working with Plot Appearance Configurations 
(CFG Files) for more information. 

 AutoCAD 2000 and later versions allow you to set the line weights of layers and 
individual objects. By default, M-Color ignores these line weights and uses only the line widths 
you specify in the Plot Appearance (CFG) dialog box in M-Color. You can make M-Color follow 
the AutoCAD line weight settings by turning off the “Ignore AutoCAD line weights” option in the 
Settings dialog box in M-Color. When this setting is turned off, the line weight specified with 
AutoCAD overrides the line width specified in the Plot Appearance (CFG) dialog box in M-Color. 
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Adding Hand-Drawn Effect 
You can use different effects (curve, deviate, move ends, break and vary width, multiple line 
segments) to make the drawing look like it was hand-drawn. This is an excellent feature for use in 
casting initial sketches from your designs, for example. Like other plot appearance settings, this 
feature is also controlled by CFG layers in M-Color. Use the Plot Appearance (CFG) dialog box to 
define hand-drawn effect to layers. 

M-Color comes with some readily defined presets to allow you to explore the possibilities of the 
hand-drawn effect. You can also define your own set of presets and reuse the settings with ease. 
See Working with Plot Appearance Configurations (CFG Files) for more information. 
 

Adding Drop Shadows 
You can add drop shadows with the click of a button. Adjust the angle, distance and feathering of 
the shadow to give depth and flair to your layout. See Working with Plot Appearance 
Configurations (CFG Files) for more information. 
 

Defining a Plot Paper 

What is a plot paper? 
A “plot paper” in M-Color means a paper frame object in your AutoCAD drawing which defines 
the area to be plotted, the size of the plot and the plot scale. The paper frame object is in fact an 
AutoCAD polyline object which contains Extended Entity Data. 

When you click the Preview and Plot command in M-Color, M-Color plots the area defined by the 
paper frame object. 
 

Defining a Plot Paper 
To define the plot paper: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Specify the paper size, orientation, plot scale and AutoCAD drawing units using the controls 
in the dialog box. 

3 Position the plot paper by clicking Point on Screen < under the Paper Frame Positioning 
section. 

4 Once you have defined the plot paper, click Zoom to Paper Frame to see the whole plot paper 
on screen and to ensure it appears as you wanted it to appear. 

5 Finish the paper definition by clicking OK. 
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 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

 The plot paper is saved with your AutoCAD drawing. You do not need to respecify the 
plot paper each time before plotting. 

See the Set Paper Command for more information. 
 

Using Standard Paper Sizes 
To define a plot paper using standard paper size: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select a standard paper size from the list of paper sizes. 

3 Set other plot paper properties and position the paper frame in the drawing. 

4 Finish the paper definition by clicking OK. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Defining a Custom Paper Size 
To define a custom size plot paper in AutoCAD by entering paper dimensions: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select Custom Size from the Paper Size list box. 

3 Enter the dimensions of the custom paper size in the width and height edit boxes below the 
Paper Size list box. 

4 Set other plot paper properties and position the paper frame in the drawing. 

5 Finish the paper definition by clicking OK. 

To define a custom size plot paper in AutoCAD by pointing paper corner points from the drawing: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Click Corners < and point paper frame corners from the AutoCAD drawing when prompted. 

3 When prompted, enter the plot scale to allow M-Color to calculate the paper's dimensions. 

4 Finish the paper definition by clicking OK. 
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 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Specifying Paper Orientation 
To specify the plot paper's orientation in AutoCAD: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Click Portrait or Landscape depending on the desired orientation. 

3 Set other plot paper properties and position the paper frame in the drawing. 

4 Finish the paper definition by clicking OK. 

 You can also freely rotate the plot paper in the drawing by using the Rotation controls in 
the Set Paper dialog box. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Specifying Plot Scale 
To specify the plot scale of the AutoCAD drawing: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Enter the desired plot scale in the Plot Scale edit box. 

3 Set other plot paper properties and position the paper frame in the drawing. 

4 Finish the paper definition by clicking OK. 

 The scale that you enter in the Plot Scale edit box is the true plotting scale and 
independent of the units being used. For example, to plot in scale 1:200, enter 200 in the edit box. 
This means that 1 millimeter on paper corresponds to 200 millimeters in real world. Equally, it 
means that 1 inch on paper corresponds to 200 inches in real world. 

 In paper space in AutoCAD the plot scale of the M-Color paper frame should normally be 
set to 1:1. In paper space, you define the scale of each viewport by setting its zoom level. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
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Fitting a Drawing Area to Paper 
To fit a specific area of the drawing to the currently selected plot paper: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select the desired paper size and orientation and make sure AutoCAD drawing units have been 
set correctly. 

3 Click Fit Area to Paper < and point the corners of the area you want to fit on the current plot 
paper. 

4 M-Color calculates the appropriate plot scale and also repositions the paper frame in the 
drawing. 

5 Finish the paper definition by clicking OK. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Specifying AutoCAD's Drawing Units 
You need to tell M-Color what drawing units you are using in your AutoCAD drawing to allow M-
Color to calculate paper sizes and plot scales properly. 

To tell M-Color what drawing units are used in the drawing: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select appropriate units from the AutoCAD Drawing Units list. 

3 Set other plot paper properties and position the paper frame in the drawing. 

4 Finish the paper definition by clicking OK. 

 “AutoCAD drawing units” means the real-world unit that you are thinking when you are 
drawing in AutoCAD. 

Typically architects use inches or millimeters, and mapping engineers use meters. 

Example: If you are drawing a floor plan and a one-unit line in your AutoCAD drawing 
corresponds to 1 millimeter in real world, your AutoCAD drawing unit is millimeter. 

Example: If you are drawing a map where the distance between two coordinate crosses in 
your AutoCAD drawing is 200 AutoCAD units and you know that the distance in real world is 200 
meters, your AutoCAD drawing unit is meter. 
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 In paper space in AutoCAD, drawing units should typically be set to either millimeters or 
inches. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Positioning the Paper Frame 
To position the paper frame in the AutoCAD drawing: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select appropriate paper size, orientation and plot scale. 

3 Click Point on Screen < under the Paper Frame Positioning section to position the paper frame 
in the AutoCAD drawing. 

4 Finish the paper definition by clicking OK. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

See the Set Paper Command for more information. 
 

Viewing the Plot Paper 
To view the whole plot paper on the AutoCAD screen: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select appropriate paper size, orientation and plot scale. 

3 Click Zoom to Paper Frame under the Paper Frame Positioning section to position the paper 
frame in the AutoCAD drawing. 

4 Finish the paper definition by clicking OK. 

 The following properties of the plot paper must be properly set before the plot paper can 
appear in its correct size in the AutoCAD drawing: Paper size, plot scale and AutoCAD drawing 
units. 

 If you cannot see the paper frame after clicking Zoom to Paper Frame, make sure that the 
M-COLOR layer is not frozen or off. The paper frame polyline is placed on that layer in the 
AutoCAD drawing. 

See the Set Paper Command for more information. 
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Specifying the Default Paper Size 
To specify the default paper size and properties for all new drawings: 

1 Click Set Paper on the M-Color menu in AutoCAD. The Set Paper dialog box will appear. 

2 Select desired paper size, orientation, plot scale and other properties. 

3 Click Set as Default. 
4 Finish the paper definition by clicking OK. 

See the Set Paper Command for more information. 
 

Printing from AutoCAD's Paper Space 
With M-Color you can also plot from AutoCAD's paper space (layout tabs). Use Preview and Plot 
command in M-Color menu to plot the drawing. 
 

Previewing the Drawing 

What is M-Color Preview? 
M-Color Preview is a Windows application that lets you preview your plot before requesting a 
hardcopy. Preview allows you to check your plot on screen in full color so that you can find the 
mistakes before plotting on paper. 

Once you are satisfied with the appearance of the plot in the preview, you can easily print it on 
paper by clicking Print on the File menu in M-Color Preview. 

MCL Files 

M-Color Preview deals with files with the extension .mcl. An MCL file is produced when you 
click the Preview and Plot command on the M-Color menu in AutoCAD. The MCL files contains 
the M-Color plot in a special format which makes it possible to efficiently view and zoom the 
drawing in full color and even change the colors or the plotting order of layers in the drawing. 

You can also efficiently use MCL files to store ready plots for later use. The MCL file contains 
both the graphical representation of AutoCAD objects and the fill style, outline width and outline 
style settings for the drawing. 

 An MCL files does not include raster images, it only links to the raster image files. This is 
to save disk space and achieve better processing times. When sending an MCL files to other users, 
you must also send all associated raster images files (e.g. TIFF files). 
 

Plotting to a Preview File 
To plot your AutoCAD drawing for previewing: 

1 Click Preview and Plot on the M-Color menu in AutoCAD. 

2 M-Color prompts for the plot file name. Accept the default by clicking Save. 

3 M-Color plots the drawing to a previewable MCL file and opens it in M-Color Preview. 
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 By default, M-Color prompts for the plot file name. If you want M-Color to always use 
the name of the current drawing as the plot file name without prompting, click Settings on the M-
Color menu in AutoCAD and, under the General tab, turn on the Do not prompt for plot file name 
option. 

 By default, M-Color launches M-Color Preview automatically. To disable automatic 
previewing, click Settings on the M-Color menu in AutoCAD and, under the General tab, turn off 
the Automatically launch preview option. 
 

Opening the Drawing in M-Color Preview 
By default, M-Color automatically opens the drawing in M-Color Preview when you click the 
Preview and Plot command on the M-Color menu in AutoCAD. 

If you have disabled automatic launching of preview, or if you want to preview an MCL file which 
you have previously created, you need to manually start M-Color Preview and open the MCL file. 

To open an MCL file in M-Color Preview: 

1 To start M-Color Preview, click Start on your Windows task bar. Then click Programs, M-
Color and finally the M-Color Preview icon. 

2 To open an MCL file in M-Color Preview, click Open on the File menu and select the MCL 
file which you want to open. 

 To produce an MCL file from an AutoCAD drawing, click Preview and Plot on the M-
Color menu in AutoCAD. 
 

Zooming and Panning 
When you have opened your drawing in M-Color Preview, you can use the zooming and scrolling 
features of M-Color Preview to check the plot. Zooming allows you to magnify details of the plot 
and scrolling allows you to move the view to the areas that do not currently fit on the screen. 

To zoom in by pointing a window: 

1 Click the  button on the toolbar. The mouse pointer changes to a magnifying glass. 

2 Point the first corner of the desired zoom window. Hold down the mouse button and drag the 
mouse pointer to the other corner of the desired zoom window. A rubber-band rectangle will 
show you the size of the zoom window. 

To quickly zoom in by 200%: 

1 Click the  button on the toolbar. The mouse pointer changes to a magnifying glass. 

2 Point your mouse to the area in the drawing which you want to magnify, and click the left 
mouse button. M-Color Preview magnifies the area by 200%. 
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To zoom out: 

1 Click the  button on the toolbar. 

To zoom previous: 

 Click the  button on the toolbar or Click the right mouse button while the current mouse 
pointer is a magnifying glass.     

 M-Color Preview goes back to the previous zoom level. 

To make the whole plot width fit in the current window: 

1 Click the  button on the toolbar. 

To make the whole plot fit in the current window: 

1 Click the  button on the toolbar. 

 When zooming in, you do not need to repeatedly click the  button on the toolbar. M-
Color Preview will remain in zooming mode, which is indicated by the magnifying glass mouse 
pointer. 

To move the drawing display in the window: 

1 Click the  button on the toolbar. The mouse pointer changes to a hand cursor. 

2 Position the mouse pointer on the drawing area. 

3 Hold down the left mouse button and drag the drawing display in the desired direction. 

To scroll left, right, up or down using the scroll bars: 

1 Click the arrows on the horizontal or vertical scroll bars in the plot's window. You can also 
click on the scroll bar itself to scroll by a full screen. 

 

Revising the Drawing 
When previewing your plot, you often find that it still includes mistakes, either in the drawing 
objects or in the color settings. 

While previewing the plot in M-Color Preview, it is still possible to edit the Plot Appearance 
specified for the drawing. This means you can change fill styles, outline widths, outline styles and 
the plotting order of CFG layers without going back to AutoCAD. 

To edit color settings or layer plotting order: 

1 Click Plot Appearance (CFG) on the Edit menu in M-Color Preview or Click the  button 
on the toolbar. 
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2 The Plot Appearance dialog box appears. You can edit layer settings such as fill styles, outline 
widths and outline styles by using the controls in the dialog box. 

To change the plotting order of layers, drag the CFG layers up and down in the layer list. 

1 By default, your changes are immediately updated to the drawing being previewed. If you 
have turned off the Auto-update screen option, you can realize the changes by clicking the 
Update button. 

2 To confirm the changes to the drawing, click OK. 

See Working with Plot Appearance Configurations (CFG Files) for more information. 
 

Document Security 
The MCL file can be protected with a password for certain operations. 

The protected operations include: 

 Opening the document 
 Printing and exporting (including PDF, PS, raster formats, copy to clipboard) 
 Accessing the Plot Appearance configuration file (CFG) of the document 

To modify the security settings of an MCL document: 

1 Click Document Security on the File menu in M-Color Preview. 

2 Click Protect this MCL document. 
3 Define password with confirmation under Define Password. 

4 Select the protected operations under Protected Operations. 

5 Click OK. 

6 Save the MCL file by selecting Save on the File menu in M-Color Preview. 

See the Document Security command for more information. 
 

Setting the Default Location for MCL Files 
To set the default location for MCL files: 

1 Click Settings on the M-Color menu in AutoCAD 

2 Click the Directories tab. 

3 Select MCL as the File type. 

4 Select the default location for MCL files under Default directory. 

5 Click OK. 

Setting the default location of MCL files affects the default location where the generated MCL file 
is stored when the Preview and Plot command is entered in AutoCAD. 
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Working with Plot Appearance Configurations 
(CFG Files) 

What is a CFG file? 
The term CFG file in M-Color refers to a Plot Appearance configuration file, which defines the fill 
styles, effects, outline widths and outline styles for AutoCAD objects. The colors and line widths 
of the objects in the drawing are defined by the selected CFG file. 

You can think of the AutoCAD drawing as the “geometry”, and the CFG file as the “visualization 
settings”. Understanding this division allows you to make your work more productive. You can 
use the same geometry (AutoCAD drawing) to produce multiple plots with different visual aspects 
by using a different CFG file for each plot. Or, you can reuse the visual aspects defined in a single 
CFG file to plot multiple AutoCAD drawings. 

As its name suggests, a CFG file is a separate file on your hard disk. You can copy and move it 
just as any file and also share it with other users. 

You can manage multiple CFG files and use the same CFG file for several drawings. Switching 
between CFG files does not modify the AutoCAD drawing itself, it only changes the drawing 
appearance when plotted with M-Color. 

With the help of CFG files, you can easily and efficiently manage different Plot Appearance 
configuration for different drawing types. You can also quickly produce different types of plots 
from the same drawing by using several CFG files: one could define suitable settings for a full 
color presentation plot, another could define settings for a black and white draft plot without any 
color fills. 

Managing CFG files is one of the key features of M-Color. It is also important that you understand 
the way of thinking behind the CFG files. See The Principles of Plot Appearance Settings (CFG 
Files) for more information. 
 

Modifying a CFG File 
You can modify a CFG file (a Plot Appearance configuration file) by using the Plot Appearance 
dialog box of M-Color in either AutoCAD or in M-Color Preview. 

Whether you want to modify the Plot Appearance in AutoCAD or in M-Color Preview depends on 
your personal preferences. Usually it is easier to make the modifications in M-Color Preview, 
because M-Color Preview will immediately show the effects of the modifications on the drawing 
being previewed. 

The following topics describe how you can modify the CFG file. 
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AutoCAD Layers vs. CFG Layers 
It is important to understand the difference between the layers in your AutoCAD drawing (= 
AutoCAD layers) and the layers in the Plot Appearance dialog box in M-Color (= CFG layers). 
Although they are closely related, they are not the same. 

The CFG layer list in Plot Appearance dialog box is independent from the AutoCAD layer list in 
your drawing. Modifying the CFG layers (e.g. adding, modifying or removing) does not affect the 
AutoCAD drawing or its layers in any way. 

The CFG layer definition includes two condition fields: layer name condition and color index 
condition. By specifying the layer name condition, you can control the appearance of objects 
depending on their AutoCAD layer. For example, if your drawing contains a layer called LAKES, 
defining a CFG layer with layer name condition LAKES allows you to set plotting attributes (fill 
style, outline width and outline style) that apply to all objects on the LAKES layer in AutoCAD. 

The layer name conditions of CFG layers can contain wildcards. For example, a CFG layer with 
layer name condition LAKES_* would control the appearance of objects on both a layer called 
LAKES_BIG and a layer called LAKES_SMALL in the AutoCAD drawing. See Changing the 
Layer Name Condition of a CFG Layer in the CFG File for more information. 

You do not need to specify all your AutoCAD layers in the CFG file. All objects that do not match 
the conditions of any CFG layers in the CFG file are plotted according to the properties of a 
special layer called ~Remaining_objects. See The "~Remaining_objects" Special Layer for 
more information. 
 

Opening a CFG File for Editing 
To open a CFG file for editing in M-Color Preview: 

1 Open a drawing (an MCL file) for previewing: 

2 Click Plot Appearance (CFG) on the Edit menu or click the  button on the toolbar. 

3 The Plot Appearance dialog box appears. 

4 If the CFG file currently displayed in the dialog box is not the one you want to modify, open 
another CFG file by clicking Open CFG. 

5 Modify the CFG file as desired. 

6 When you have completed the modifications, click OK to save the changes and to close the 
dialog box. At this time, the changes are saved only to the MCL document, not to the CFG file 
on disk. The changes will be saved to the CFG file on disk when you save the MCL document. 

To open a CFG file for editing in AutoCAD: 

1 Click Plot Appearance (CFG) on the M-Color menu. 

2 The Plot Appearance dialog box appears. 

3 If the CFG file currently displayed in the dialog box is not the one you want to modify, open 
another CFG file by clicking Open CFG. 

4 Modify the CFG file as desired. 
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5 When you have completed the modifications, click OK to save the changes and to close the 
dialog box. The changes are saved to the CFG file on disk. 

 

Adding a New CFG Layer to the CFG File 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To add a new CFG layer to the CFG file: 

1 Click Add CFG Layer to List. 
2 The New CFG Layer dialog box appears. 

3 Select from the list of AutoCAD layers in the current drawing, or enter the layer name 
condition and color index condition of the new CFG layer by clicking Define Layer Name and 
Color Index Conditions button. 

4 Click OK to create the new CFG layers. 

5 The new CFG layers appear in the list. 

If your AutoCAD drawing contains a large number of layers, you may want to filter the drawing 
layers to more easily find the AutoCAD layers that you want to add. You can select from the list of 
predefined filters, or click the ... button next to the filter selection to design your own filter. 

You can filter AutoCAD layers according to the name, color, on/off state and frozen/thawed state 
of the layer. You can also filter AutoCAD layers based on whether the AutoCAD layer is used in 
AutoCAD (that is, whether the AutoCAD layer contains objects or not). In addition to these 
AutoCAD-related properties, you can filter AutoCAD layers based on whether the AutoCAD layer 
has already been added to the CFG file or not. 
 

Setting a Fill Style to a Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To set a fill style for a layer: 

1 Select the layer from the list of layers. You can select multiple layers by holding down the 
Ctrl key. 

2 Click Fill Style. 

3 The Select Style dialog box appears. 

4 Select the desired fill style. To specify an empty fill (no fill), select None. 

5 Click OK. 
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In the Select Style dialog box, you can either pick a predefined style from a style palette or define 
a custom style. To select a predefined style from a palette, click Style from palette and click on the 
style you want to use. You can change the displayed style palette by selecting another recently 
used palette from the drop list or by clicking Browse and selecting a style palette file (PAL file). 
To define a custom style, click Custom style and then Edit. 

See Select Style Dialog Box for more information. 
 

Setting an Outline Width to a Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To define line width for a layer: 

1 Select the layer from the list of layers. You can select multiple layers by holding down the 
Ctrl key. 

2 Click Width. 

3 The Outline Width dialog box appears. 

4 Enter the desired line width. 

5 Click OK. 

 Specifying zero as the line width will not make the line invisible. Instead, M-Color will 
plot the objects using the thinnest available line width available in your printer. With some high-
resolution devices, the lines may appear nearly invisible. 

 AutoCAD 2000 and later versions allow you to set the line weights of layers and 
individual objects. By default, M-Color ignores these line weights and uses only the line widths 
you specify in the Plot Appearance (CFG) dialog box in M-Color. You can make M-Color follow 
the AutoCAD line weight settings by turning off the “Ignore AutoCAD line weights” option in the 
Settings dialog box in M-Color. When this setting is turned off, the line weight specified with 
AutoCAD overrides the line width specified in the Plot Appearance (CFG) dialog box in M-Color. 
 

Setting an Outline Style to a Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To set an outline style for a layer: 

1 Select the layer from the list of layers. You can select multiple layers by holding down the 
Ctrl key. 

2 Click Outline Style. 

3 The Select Style dialog box appears. 

4 Select the desired outline style. To specify an invisible outline (no outline), select None. 

5 Click OK. 



 

 Chapter 4    USING M-COLOR 35 
  

In the Select Style dialog box, you can either pick a predefined style from a style palette or define 
a custom style. To select a predefined style from a palette, click Style from palette and click on the 
style you want to use. You can change the displayed style palette by selecting another recently 
used palette from the drop list or by clicking Browse and selecting a style palette file (PAL file). 
To define a custom style, click Custom style and then Edit. 

See Select Style Dialog Box for more information. 
 

Setting a Hand-Drawn Effect to a Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To set an effect for a layer: 

1 Select the layer from the list of layers. You can select multiple layers by holding down the 
Ctrl key. 

2 Click Effects. 

3 The Effects dialog box appears. 

4 Enable the hand-drawn effect and click Edit to edit the preferences of the effect in the Define 
Hand-drawn Effect dialog. Click OK to apply the settings. 

5 Click OK. 

In the Define Hand-drawn Effect dialog box, you can either import a predefined preset or define a 
custom effect style. To select a predefined preset, click Import and click on the preset you want to 
use. 

See Define Hand-drawn Effect dialog for more information. 
 

Setting a Drop Shadow to a Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To set a drop shadow for a layer: 

1 Select the layer from the list of layers. You can select multiple layers by holding down the 
Ctrl key. 

2 Click Effects. 

3 The Effects dialog box appears. 

4 Enable the drop shadow effect and click Edit to edit the preferences of the effect in the Define 
Drop Shadow dialog. Click OK to apply the settings. 

5 Click OK. 
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In the Define Drop Shadow dialog box, you can either import a predefined preset or define a 
custom effect style. To select a predefined preset, click Import and click on the preset you want to 
use. 

See Define Drop Shadow dialog for more information. 
 

Changing the Plotting Order of Objects 
The plotting order of layers is defined by their order in the CFG file. A layer that is above other 
layers in the CFG layer list will also be plotted on top of those layers. 

 Objects follow the plotting order of their CFG layer. The drawing order of objects in 
AutoCAD has no effect. 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To change the plotting order of layers: 

1 Select the layer from the list of layers. 

2 Hold down the left mouse button and drag the layer to its new position in the layer list. 

3 Release the left mouse button when the layer is in its new position. 
 

Changing the Layer Name Condition of a CFG Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To change the layer name condition of a CFG layer: 

1 Select the layer from the list of CFG layers. 

2 Click Layer Name and Color Index. 

3 The Define Object Property Criteria dialog box appears. 

4 Enter the layer name condition for the CFG layer in the edit box. 

5 Click OK. 

 Layer name conditions can contain wildcards (*, ? and #). By using wildcards, you can 
make one CFG layer refer to several AutoCAD layers. The meanings of the wildcard characters 
are as follows: 

*   any string (= any number of any characters) 

?   any single character 

#   any single digit 
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Removing a Layer from the CFG File 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

To remove one or more CFG layers: 

1 Select the CFG layer from the list of layers. You can select multiple layers by holding down 
the Ctrl key. 

2 Click Remove CFG Layer from List. 
3 The selected CFG layers are removed from the layer list. 
 

The "~Remaining_objects" Special Layer 
The CFG file usually contains a special layer called ~Remaining_objects. This CFG layer controls 
the properties of all those AutoCAD objects that do not match the object property criteria of any 
other CFG layer in the CFG file. 

Example: Your AutoCAD drawing may contain hundreds of layers. If the CFG file 
contains only a few layers, all other layers are plotted according to the settings of the 
~Remaining_objects special layer. 

In general, the ~Remaining_objects special layer should be defined no fill (None) and a thin black 
outline. 

 Thanks to the ~Remaining_objects special layer, you do not need to specify all AutoCAD 
layers in your drawing in the CFG file. Most of them should probably plot with a black thin line, 
and thus you can leave them out from the CFG file, in which case they will follow the settings of 
the ~Remaining_objects special layer. 
 

Working with Layers in XREF Drawings 
AutoCAD allows you to attach other drawings to your main drawing as external references 
(XREFs). When you attach an XREF to your main drawing, the layers of the XREF drawing will 
be prefixed by the name of the XREF in the main drawing. Because the definition of fill styles, 
outline widths and outline styles is typically based on layer names in M-Color, you should pay 
special attention to how you want the XREF layers to be plotted. 

To tell M-Color to ignore the XREF prefixes in AutoCAD layer names: 

1 Click Options in the Plot Appearance dialog. The Plot Appearance - Options dialog box 
appears. 

2 Check the Ignore XREF prefixes in AutoCAD layer names option. 

3 Click OK. 
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The XREF prefix of a layer name includes the part before the | (“pipe”) character and the | 
character itself. When this option is turned on, the layers in the main drawing and the layers with 
the same names in XREF drawings will plot with the same settings and you never need to add the 
XREF prefix to the layer name condition in the Plot Appearance (CFG) dialog box. 

If the Ignore XREF prefixes in AutoCAD layer names option in the Plot Appearance - Options 
dialog box is turned off, M-Color will use the complete layer name (including the XREF prefix) 
when matching AutoCAD layer names to the layer name conditions of CFG layers. In this case, 
the layers in the main drawing and the layers in XREF drawings require separate settings in the 
Plot Appearance (CFG) dialog box. 

 You can use wildcards effectively with XREF layers. For example, defining a CFG layer 
with layer name condition *|WINDOW and setting a Blue fill style to it will cause the objects on 
the WINDOW layer in all XREFs to be filled with Blue. Note that the objects on the WINDOW 
layer in the main drawing will not follow this setting because the layer name in the main drawing 
does not contain the | character. 

 If the main drawing and the XREFs all follow a similar layering scheme, you should 
generally turn on the Ignore XREF prefixes in AutoCAD layer names option in the Plot 
Appearance - Options dialog box. This allows you to manage a layer that appears in the main 
drawing and all XREFs with a single CFG layer. 
 

Using the "Scale of the Outline Widths" Setting 

 In general, you should have the Scale of the Outline Widths setting turned off in the Plot 
Appearance - Options dialog so that it does not affect the appearance of your plots. 

The Plot Appearance - Options dialog box contains a setting named Scale of Outline Widths. This 
setting lets you define whether you want your line widths to be scaled with the document if you 
plot it in another scale, or to use the same fixed widths in all plotting scales. 

By default, the scale of the outline widths is disabled. In this mode, the line widths will always 
output using the width setting of the layers and the widths will be the same in all plotting scales. 

To tell M-Color to scale the line widths depending on the plot scale: 

1 Click Options in the Plot Appearance dialog. The Plot Appearance - Options dialog box 
appears. 

2 Activate the Scale of the Outline widths by checking the Active check box next to the Scale of 
the Outline widths edit box. 

3 Enter the appropriate plot scale value to the edit box. See the description below for defining 
the appropriate value. 

4 Click OK. 



 

 Chapter 4    USING M-COLOR 39 
  

The scale of the outline widths is the plot scale in which you want the line widths to be what you 
have defined in the Plot Appearance dialog box. When plotting using other plot scales, the line 
widths will be scaled accordingly. 

Example: You have specified the scale of the outline widths to be 1:2000. You have 
specified a line width of 2.0mm for a layer called ROADS. 

1 If you plot the drawing in scale 1:2000, the lines on layer ROADS will be plotted using width 
2.0 mm. 

2 If you plot the drawing in scale 1:1000, the lines on layer ROADS will be plotted using width 
4.0 mm. 

3 If you plot the drawing in scale 1:10000, the lines on layer ROADS will be plotted using width 
0.4 mm. 

If you then turn off the scale of the outline widths setting and plot again in the above plot scales, 
the lines on layer ROADS will be plotted using width 2.0 mm in all plot scales. 
 

Drawing Objects When Multiple CFG Layers Are Matching 
Sometimes an AutoCAD object matches more than one CFG layer in the Plot Appearance 
configuration. For example, a circle drawn in AutoCAD on layer TREE1 with color index 1 (red) 
could match the following CFG layers: 

 Layer name condition TREE*, color index condition Any. 
 Layer name condition Any (*), color index condition 1 (red). 

Usually it is preferable that both of these layers are applied and the drawing order makes the object 
look complete. However, sometimes it may be desirable to control whether all layers are applied or 
the topmost or the bottommost only. 

To control this property of a CFG in the Plot Appearance dialog: 

1 Click Options in the Plot Appearance dialog. The Plot Appearance - Options dialog box 
appears. 

2 Under If object matches multiple CFG layers select Plot all to apply all matching CFG layers 
(default), Plot topmost only to apply only the highest of the matching CFG layers in the list 
and Plot bottommost only to apply only the lowest of the matching CFG layers in the list. 

 The If object matches multiple CFG layers option is applied to the whole drawing and it is 
not possible to adjust the option by individual CFG layers. 
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Copying Style and Effects from Another Layer 

 To perform this operation, you first need to open a CFG file for editing in the Plot 
Appearance dialog box. See Opening a CFG File for Editing for more information. 

You can set the fill style or outline style of a CFG layer to be the same as the fill style or outline 
style of another layer in the same CFG. 

To copy a style from another layer and use it as the fill style for the layer: 

1 Move the mouse pointer over the target layer. Click the right button of the mouse and select 
Copy Fill Style From on the menu that appears. 

2 The mouse pointer changes to an arrow. Point the style you want to use. You can click either 
on a fill style or an outline style of another layer. 

To copy a style from another layer and use it as the outline style for the layer: 

1 Move the mouse pointer over the target layer. Click the right button of the mouse and select 
Copy Outline Style From on the menu that appears. 

2 The mouse pointer changes to an arrow. Point the style you want to use. You can click either 
on a fill style or an outline style of another layer. 

To copy effects from another layer and use them as the effects for the layer: 

1 Move the mouse pointer over the target layer. Click the right button of the mouse and select 
Copy Effects From on the menu that appears. 

2 The mouse pointer changes to an arrow. Point the effects you want to use. 
 

Importing AutoCAD's Pen Settings or Plot Styles 
It is possible to create a new CFG file based on AutoCAD's pen settings file (PCP/PC2 in 
AutoCAD R14) or based on AutoCAD's color based plot style table file (CTB in AutoCAD 2000-
2004). This feature helps to create a similar looking drawing in M-Color as when using a pen 
settings or plot style table file in AutoCAD. 

To import a pen settings or a plot style table file in the Plot Appearance dialog as a new CFG file: 

1 Click Import in the Plot Appearance dialog. File selection dialog appears. 

2 Select the PCP/PC2/CTB file from which the settings are imported (for example, C:\Program 
Files\AutoCAD 2004\Plot Styles\acad.ctb). 

 M-Color emulates the settings as defined for each of the 255 color indices, resulting in 
255 CFG layers in the CFG file. The color based CFG layer definitions are more awkward to 
manage and so the layer-based approach in defining style definitions is preferred. 

When AutoCAD's pen settings file is imported, the line widths of objects are applied. The outline 
color of the objects is set to black. 
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When AutoCAD's plot style table file is imported, the following properties are applied: 

 Outline color (Solid color fill style for outline) with Grayscale and Screening taken into 
account. 

 Outline weight.        

The Line End Style and Line Join Style options are ignored. Use the Flat line ends option in 
Expert Settings instead. 
 

Reusing Plot Appearance Configurations in Other Drawings 
You can use the same CFG file with other drawings of the same type. For more information about 
efficiently managing CFG files and different drawing types, see the following topics. 
 

Managing CFG Files 
The CFG file defines the fill styles, outline widths and outline styles for the drawing. As it is a file 
on your hard disk, you can naturally have multiple CFG files, each of which has a unique name. 

You can manage multiple CFG files with M-Color. Each file defines a Plot Appearance 
configuration. Typically, you would have different CFG files for each drawing type or for each 
plot type. 

The CFG file selection is saved with the AutoCAD drawing. Thus, the drawing will automatically 
use the same CFG file the next time you open it. 

 You do not need a different CFG file for each AutoCAD drawing. It is better to try to 
share the same CFG file with different drawings of the same type to get the most out of the 
productivity increase a well-planned use of CFG files can bring to you. Also, you should try 
sharing the same CFG file with other users. 

Usually, you need a different CFG files for all those drawings whose AutoCAD layer structure is 
considerably different. A different layer structure means you are dealing with a different type of 
drawing. 
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The following is an example of a well-planned set of M-Color CFG files in a mapping company: 

File name  Description 

Citymap.cfg  For plotting color presentation plots of city maps. 

Roadmap.cfg  For plotting color presentation plots of road maps. 

Forest.cfg  For plotting color plots of forest classification maps. 

ForestBW.cfg  For plotting black and white drafts of forest classification maps 
(without any color fills). 

The CFG files are stored in a central location on the network and are marked read only to protect 
them against unintended changes. The default location of CFG files for all users is set to this 
central network location. All users in the company are sharing the same CFG files on the network 
to plot these types of drawings. 

The company achieves benefits in increased productivity and plot quality. Each time a CFG file is 
enhanced or modified (such as adding new layers or changing line widths), the improved CFG file 
is immediately at the use of the whole organization. 
 

Setting the Default Location for CFG Files 
To set the default location for CFG files: 

1 Click Settings on the M-Color menu in AutoCAD 

2 Click the Directories tab. 

3 Select CFG as the File type. 

4 Select the default location for CFG files under Default directory. 

5 Click OK. 

Setting the default location of CFG files does not prevent using files from other locations. The 
default location is just the default starting point for Open and Save As operations. 
 

Setting the Default CFG File 
To specify the default CFG file: 

1 Click Settings on the M-Color menu in AutoCAD 

2 Click the Directories tab. 

3 Enter the full path of the default CFG file under Default file or click Browse to select the file. 

4 Click OK. 

The default CFG file setting defines the default CFG file for new drawings and for drawings that 
have never been plotted with M-Color before. 
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Printing the Drawing 

Previewing the Drawing Before Printing 
Before you can print the drawing on paper, you should preview it using M-Color Preview. See 
Plotting to a Preview File for instructions on creating the preview file and opening it in M-Color 
Preview. 

After you have checked your drawing in the preview, you can print the drawing on paper as 
described in the following topics. 
 

Selecting the Printer and the Page Size 
To select the printer and the page size in M-Color Preview: 

1 Click Print, Print Setup on the File menu in M-Color Preview. 

2 Select the printer you want to use for printing the drawing. 

3 Select the page size you want your printer to use. 

4 Click OK to accept the selection. 

 You should select at least as large page size from your printer as your MCL drawing is. 
Otherwise your drawing will not be completely plotted. Also note that the printer's page usually 
has margin areas that cannot be plotted on, so it is recommended that you select a larger paper size 
here than your MCL paper size is. 

 If you do not see your printer in the printer list, you need to install a Windows printer 
driver for it. See your printer's documentation and Windows help for more information. 
 

Viewing the Drawing's Layout on the Printer's Page 
M-Color Print Space is a viewing mode which allows you to see the printer's page size and 
margins on screen in M-Color Preview. This helps you to see how your M-Color plot is 
positioned, sized and orientated on the printer's page, and to ensure that the printer's margin areas 
will not cause important parts of your plot to be hidden. 

To turn M-Color Print Space on or off: 

1 Click the  button on the toolbar. 

2 The button's state indicates whether M-Color Print Space is currently on or off. 

When M-Color Print Space is on, M-Color Preview shows the printer's page on screen. The light 
gray areas on the edges of the printer's page indicate printer's non-printable margin areas, if any. 

The paper frame of the MCL drawing is indicated by a red dashed line. The red dashed line is not 
printed on paper. 
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Changing the Drawing's Layout on the Printer's Page 
M-Color Preview allows you to control the positioning, size and rotation of the MCL drawing on 
the printer's page or printer paper on the MCL drawing. 

To start making modifications to page layout click Page Setup on the File menu in M-Color 
Preview. 

To change the MCL document's layout on printer paper you can: 

 Use the Left, Top, Scale and MCL Rotation controls to edit the positioning of the MCL 
document. 

 Move the MCL document freely by clicking Move MCL < and defining a new position for the 
document using the mouse. 

To change the printer paper's layout on the MCL document you can: 

 Fit an area of the MCL document on the printer paper by clicking Fit Area to Printer Paper <. 
Lock the first corner of the area by clicking the left mouse button, hold it down and drag the 
mouse until the area is complete.  

 Move the printer paper freely by clicking Move Printer Paper < and define a new position for 
the printer paper. 

To complete the modifications: 

1 Click Apply to update the drawing to follow the new settings. 

2 Click OK when you want to close the Page Setup dialog box. 

 The Page Setup dialog box is a “modeless” dialog box. You can keep it open on the screen 
all the time and perform other tasks such as zooming and printing in M-Color Preview. 

By default, when you save the drawing in M-Color Preview, the selected printer and its settings, as 
well as the drawing's layout on the printer's page, are saved with the document. M-Color Preview 
will use the saved settings the next time you open the drawing. If the original drawing is open in 
AutoCAD at the time you save the MCL file in M-Color Preview, the print setup settings are saved 
to the AutoCAD drawing, too. This allows M-Color to use the same print settings even if you later 
produce a new MCL file and overwrite the old MCL file. 

If you do not want M-Color to save the print setup settings with the MCL document but always 
use the default printer instead, turn off the “Save print setup with document” option in the Expert 
Settings dialog box in M-Color 

See the Page Setup command for more information. 
 

Printing the Drawing 
When you are satisfied with the results in M-Color Preview, you can print the drawing on paper: 

1 Click Print, Print on the File menu in M-Color Preview. 

2 Make sure the printer and page size selections are appropriate. 

3 Click OK to start printing. 
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 After the print job has been processed, a printing time report is displayed. You can use the 
report to detect the most time consuming CFG layers in the drawing and reduce unnecessary 
complexity from the drawing. To turn off the displaying of the report deselect the Show printing 
time report after printing option in Expert Settings on the Edit menu of M-Color Preview. 
 

Printing to File 
Sometimes you may want to produce a plot file for the printer, instead of sending the plot data 
directly to the printer. This is especially useful if you want do any of the following: 

 Print to a printer which is not connected to your computer 
 Send the drawing to be printed at a service bureau 
 Save the final plot for taking quick reprints later 
 Troubleshoot printing problems 

To print to file in M-Color Preview: 

1 Click Print, Print on the File menu. 

2 Turn on the Print to File option in the Print Options dialog box. 

3 Click OK to start printing. 

4 You are prompted for a plot file name. Enter an appropriate directory, file name and 
extensions. .prn or an extension describing the printer's file format is typically used as the 
extension. 

5 Accept the plot file name by clicking OK. 

Printing to file produces a plot file. A plot file contains the drawing data in the printer's native 
language (e.g. HP-GL/2, RTL, PCL, PostScript). The data format depends on the printer driver 
you selected in Printer Setup as your active printer. 

To print the plot file using the printer device, you should copy it directly to the printer's port: 

1 At the MS-DOS prompt, enter copy  /b  plotfile.prn  lpt1 and press enter. 

(Substitute the plot file name and the printer's port with appropriate values.) 

2 The plot file data is transmitted to your printer and it starts printing. 

 The /b switch is required. 

 To print to a network printer, substitute lpt1 with the printer's network name. The network 
name consists of the server name and share name. \\SERVER01\LASER is an example of a 
network name. 

 Because the plot file contains data in the printer's native language, you can only print 
using the exact device for which the plot file was created. Other devices cannot process that data. 
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Scheduled Printing 
Scheduled Printing lets you define one or more documents to be printed at a specified time. You 
can also use this command to produce PDF, PS and bitmap files. 

In the following situations, scheduled printing may be very useful: 

 You have complex drawing(s) requiring heavy processing by the local computer or a printer. 
 You have several drawings or layouts to be printed and you want to prepare the whole 

drawing set to be printed at one time. 
 There is traffic at the printer and you want to set the printing to be started at a specific time. 

To add a drawing to a scheduled print batch:      

1 Open the drawing by clicking Open on the File menu in M-Color Preview. 

2 Select the printer and define the paper size and layout using the Print Setup and Page Setup 
commands. 

3 Open the Scheduled Printing dialog by clicking Print, Scheduled Printing on the File menu in 
M-Color Preview. 

4 Click Add to Jobs to add the active document to the set of scheduled jobs. 

5 Use the Start Time controls to set the start time of the printing. 

6 Click OK to save the scheduling settings. 

 The used printer and page layout are stored within the print job when OK is clicked. This 
means that the changes made to these settings of the MCL document later on have no effect when 
the scheduled printing jobs are processed. 

Repeat the steps above to add multiple print jobs to the set. 

To cancel a scheduled printing task completely you must select each job in the Jobs list and click 
the Remove Job button. Apply by clicking OK. 

If you want a job to be printed to file, select Print to File. Define the name of the output file and 
click Save. 
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Sending the Drawing to Be Printed at a Service Bureau 
You can print your drawings at a service bureau if you do not have a plotter of your own. 

 The service bureau does not need to have M-Color in order to plot your M-Color 
drawings. You can make a PDF file out of your drawing with M-Color and send that to the service 
bureau. You can also send them a ready plot file which they can plot. However, if the service 
bureau has M-Color, you can of course send them the MCL file and the associated raster image 
files.  

If the service bureau accepts PDF files, see Publish to PDF for more information. 

If the service bureau does not have M-Color, follow these steps to create a plot file which you can 
send them: 

1 Contact the service bureau and ask them which Windows printer driver you should use. Tell 
them that you 

* are using a standard Windows application 

* want to produce a ready plot file for them using their printer's Windows driver 

2 If the printer driver is available on the Windows setup CD, you can install it as any other 
printer. 

3 If the printer driver is not available on the Windows setup CD, you need to obtain it either 
from the service bureau or from the printer manufacturer's web site. 

4 Once you have installed the correct printer driver on your system, produce a plot file of your 
drawing in M-Color Preview. See Printing to File for more information. 

5 Send the plot file you just produced to the service bureau. 

6 Tell the service bureau 

* that you sent them a ready plot file for the printer 

* that they should print the file using the DOS command  copy  /b  plotfile.prn  lpt1 
 

Sending the Drawing to Be Printed at a Print House 
You can have your M-Color drawing printed at a print house. 

 The print house does not need to have M-Color in order to print your M-Color drawings. 
You can send them a ready PostScript or PDF file which they can print. 

In fact, the printing process consists of two steps you should understand: 

1 The print house or a repro service produces color-separated films of your drawing. Typically, 
four films (cyan, magenta, yellow and black), are produced. 

2 The print house prints the drawing using the films produced in the first step. 
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Producing the films is the key step from your point of view when you are considering how you can 
print your M-Color drawing at the print house. Once the films have been produced, any print 
house can do the printing work without knowledge of electronic printing. 

The films are produced using a printer device specifically designed to produce high-resolution 
images on the film material. Otherwise, it does not greatly differ from a standard printer or plotter. 

The language commonly used in producing printing films is PostScript. There are two ways to 
produce PostScript plot files in M-Color: You can use the Publish to PostScript command in M-
Color Preview to produce a generic PostScript plot file, or you can use the target device's 
Windows printer driver and print to file. The latter method may give you better control over 
device-specific PostScript settings. 

Many printing services also accept PDF files. If the service bureau accepts a PDF file, it may be 
preferred over PostScript because you can more easily check the validity of the PDF file, simply 
by viewing it in Acrobat Reader. PostScript viewers are not commonly available. 

The print house will process the PostScript or PDF file and create color separations from it. You 
do not need to be familiar with such things. 

If the print house is not able to process the PostScript or PDF file, you may want to try using 
another print house or repro service. There are great differences in the level of knowledge in print 
houses regarding electronic printing. 
 

Working with Styles and Style Palettes 

What is a style? 
A style in M-Color is a visual effect that you set to the fills or outlines of objects on a layer. A 
style can be a solid color, translucent color, gradient or bitmap texture. 

You can use a style as a fill style or as an outline style for a layer, or both. 
 

What is a style palette? 
A style palette is a collection of style definitions. A style palette allows you to store frequently 
used styles for reuse. 

When selecting a fill style or outline style in the Select Style dialog box, you can select a 
predefined style from a style palette or you can define a new custom style that does not necessarily 
need to be stored in a style palette. 

Style palettes make it easy for you to manage named styles and standardize the style usage in your 
projects. You can use the ready styles in the default style palettes and you can define new styles of 
your own. 

Technically, a style palette is a separate file on your hard disk (with extension .pal) and contains 
the style names and definitions in it. 
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The default style palette in M-Color contains over a hundred useful solid colors and some sample 
translucent colors, gradient styles and bitmap texture styles. M-Color also comes with two Pantone 
style palettes that contain the definitions of the industry standard Pantone Matching System® 
(PMS) and Pantone® Process colors. Use the Pantone color palettes if you are familiar with 
Pantone colors and want to achieve perfect color matching results when printing your drawings at 
a print house. 

You can add your own style definitions to the palettes that are installed with M-Color or you can 
store your own style definitions in one or more new style palettes that you create. 

 M-Color does not limit the number of available colors in any way. With M-Color, you can 
output all possible colors that your display device or the printer device can produce. A style palette 
is simply a convenient subset of styles that you will often need. 
 

Defining a Solid Color Style 

 You can define a style either when selecting the fill style or outline style for a layer, or 
when managing style palettes. If you are selecting the fill style or the outline style for a layer and 
want to define a new style, click Custom style in the Select Style dialog box and then click Edit. If 
you are managing palettes in the Manage Palettes dialog box and want to define a style, click New 
Style or Edit Style. This takes you to the Define Style dialog box. 

To define a solid color style in the Define Style dialog box: 

1 Type the name of the style in the Style name edit box. 

2 Select Solid color as the style type. 

3 Click Edit. The Define Color dialog box appears. 

4 Use the color tone control and the color map to define the color you want. You can also enter 
CMYK, RGB or HSB values. 

5 When you have defined the solid color, click OK to return to the Define Style dialog box. 

6 Click OK to accept the name and definition of the style and to close the Define Style dialog 
box. 

To select a solid color style from a palette, click Select from Palette. 

 When the color mode is CMYK, the Define Color dialog displays the colors that can be 
printed by most printers. When using the RGB or HSB color modes, select Hide RGB and HSB 
colors that cannot be printed to see the gamut of a Generic CMYK Printer. If you have associated 
color profile(s) for the current printer, you may select the printer from the list to see the gamut of 
the device. This option helps you to avoid selecting colors that are impossible for printers to 
produce. Bright green is a good example of these colors. See the topics under Color Management 
for more information. 

See Define Color Dialog Box for more information. 
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Defining a Translucent Color Style 

 You can define a style either when selecting the fill style or outline style for a layer, or 
when managing style palettes. If you are selecting the fill style or the outline style for a layer and 
want to define a new style, click Custom style in the Select Style dialog box and then click Edit. If 
you are managing palettes in the Manage Palettes dialog box and want to define a style, click New 
Style or Edit Style. This takes you to the Define Style dialog box. 

To define a translucent color style in the Define Style dialog box: 

1 Type the name of the style in the Style name edit box. 

2 Select Translucent color as the style type. 

3 Click Edit. The Define Color dialog box appears. 

4 Use the color tone control and the color map to define the color you want. You can also enter 
CMYK, RGB or HSB values. 

5 Adjust the transparency level of the color by entering the transparency percentage in the 
Transparency edit box. 

6 When you have defined the translucent color, click OK to return to the Define Style dialog 
box. 

7 Click OK to accept the name and definition of the style and to close the Define Style dialog 
box. 

To select a translucent style from a palette, click Select from Palette. If the selected fill style is a 
solid color fill style, the base color of the translucent fill style being defined is applied from the 
selected style. 
 

Defining a Gradient Style 

 You can define a style either when selecting the fill style or outline style for a layer, or 
when managing style palettes. If you are selecting the fill style or the outline style for a layer and 
want to define a new style, click Custom style in the Select Style dialog box and then click Edit. If 
you are managing palettes in the Manage Palettes dialog box and want to define a style, click New 
Style or Edit Style. This takes you to the Define Style dialog box. 

To define a gradient style in the Define Style dialog box: 

1 Type the name of the style in the Style name edit box. 

2 Select Gradient as the style type. 

3 Click Edit. The Gradient Style dialog box appears. 

4 Set the gradient mode, options and the starting and ending colors using the controls in the 
Gradient Style dialog box. 

5 When you have defined the gradient style, click OK to return to the Define Style dialog box. 

6 Click OK to accept the name and definition of the style and to close the Define Style dialog 
box. 
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Note that you can also set the transparency of the starting and ending colors. 

See Gradient Style Dialog Box for more information. 
 

Defining a Bitmap Texture Style 

 You can define a style either when selecting the fill style or outline style for a layer, or 
when managing style palettes. If you are selecting the fill style or the outline style for a layer and 
want to define a new style, click Custom style in the Select Style dialog box and then click Edit. If 
you are managing palettes in the Manage Palettes dialog box and want to define a style, click New 
Style or Edit Style. This takes you to the Define Style dialog box. 

To define a bitmap texture style in the Define Style dialog box: 

1 Type the name of the style in the Style name edit box. 

2 Select Bitmap texture as the style type. 

3 Click Edit. The Bitmap Texture Style dialog box appears. 

4 Load a bitmap by clicking Import and adjust the other properties of the style. 

5 To adjust brightness, tone and other properties of the bitmap face, click Edit. 
6 To adjust the transparency of the bitmap, use the transparency control. 

7 When you have defined the bitmap texture style, click OK to return to the Define Style dialog 
box. 

8 Click OK to accept the name and definition of the style and to close the Define Style dialog 
box. 

 If the brightness, tone and other properties of the bitmap are modified and the bitmap is 
large, the processing of the style may become slower. To avoid this, it is preferable to Export the 
bitmap into a file and then Import it back from the exported file. 

See Bitmap Texture Style Dialog Box for more information. 
 

Modifying a Style Palette 
You can modify a style palette by using the Manage Palettes dialog box of M-Color in either 
AutoCAD or in M-Color Preview. 

The following topics describe how you can modify the style palettes. 
 

Opening a Style Palette for Editing 
To open a style palette for editing in M-Color Preview: 

1 Click Manage Palettes on the Edit menu or Click the  button on the toolbar. 

2 The Manage Palettes dialog box appears. 

3 If the style palette currently displayed in the dialog box is not the one you want to modify, 
open another palette by clicking Open Palette 
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4 Modify the style palette as desired. When you have completed the modifications, click OK to 
save the changes and to close the dialog box. The changes are saved to the PAL file on disk. 

To open a style palette for editing in AutoCAD: 

1 Click Manage Palettes on the M-Color menu. 

2 The Manage Palettes dialog box appears. 

3 If the style palette currently displayed in the dialog box is not the one you want to modify, 
open another palette by clicking Open Palette 

4 Modify the style palette as desired. When you have completed the modifications, click OK to 
save the changes and to close the dialog box. The changes are saved to the PAL file on disk. 

 

Adding a New Style 

 To perform this operation, you first need to open a style palette for editing in the Manage 
Palettes dialog box. See Opening a Style Palette for Editing for more information. 

To add a new style: 

1 Click New Style. The Define Style dialog box appears. 

2 Enter the name of the new style in the Style Name edit box. 

3 Select the appropriate style type (solid color, translucent color, gradient or bitmap texture) and 
click Edit. 

4 Define the properties of the style and click OK when finished. 

5 Click OK to close the Define Style dialog box and add the new style to the style palette. 

See Define Style Dialog Box for more information. 
 

Changing an Existing Style 

 To perform this operation, you first need to open a style palette for editing in the Manage 
Palettes dialog box. See Opening a Style Palette for Editing for more information. 

To change the definition of an existing style: 

1 Select the style from the list. 

2 Click Edit Style. 

3 Change the definition of the style. 

4 Click OK. 
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Removing a Style 

 To perform this operation, you first need to open a style palette for editing in the Manage 
Palettes dialog box. See Opening a Style Palette for Editing for more information. 

To remove a style from the palette: 

1 Select the style from the list. 

2 Click Remove Style. 
 

Copying a Style from One Palette to Another 

 To perform this operation, you first need to open a style palette for editing in the Manage 
Palettes dialog box. See Opening a Style Palette for Editing for more information. 

To copy a style from the current palette to another palette: 

1 Move the mouse cursor on top of the style you want to copy, click the right button of the 
mouse and select Copy on the menu that appears. 

2 Open the target palette by clicking Open Palette. 

3 Add the copied style to this palette by clicking the right mouse button on top of the style list 
and select Paste. 

 If you have multiple M-Color Preview applications open, the copy/paste operation works 
between the applications via the Windows clipboard. 
 

Creating a New Style Palette 

 To perform this operation, you first need to open a style palette for editing in the Manage 
Palettes dialog box. See Opening a Style Palette for Editing for more information. 

To create a new empty palette: 

1 Click New Palette. 

2 Add styles to the palette. 

3 Click OK to save changes to the new palette and close the Manage Palettes dialog box. You 
will be prompted for the name of the new palette. 

To create a new style palette based on an existing style palette: 

1 Open the style palette which you want to use as the basis for the new palette. 

2 Click Save Palette As to save the style palette with a new name. 

3 Add, modify and remove styles as necessary. 

4 Click OK to save changes to the new palette and close the Manage Palettes dialog box. 
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Managing Style Palettes 
A style palette defines a set of named styles that you can use in your M-Color plots. 

You can manage multiple color palettes with M-Color. You can divide styles to different palettes 
in any way you choose and you can select styles from multiple palettes into a single CFG file. 

One use for multiple color palettes would be creating differently named style sets for different 
types of projects. In a mapping project the users might want to use styles that are named and 
defined according to their intended use in the mapping drawings (e.g. Forest, Lawn, Bushes). The 
same styles would not be appropriate for an architectural drawing. An architectural style palette 
could contain styles such as Bricks, Floor pattern, Sky etc. Note that it would still be possible to 
use styles from both palettes in a single drawing if necessary. 

Another case when multiple style palettes are useful is if you need to output your drawing with 
different output devices. Creating a separate style palette for each device allows you to adjust the 
colors for each device independently. In this case, the device-specific style palettes would contain 
definitions for those styles that need to be defined differently on different output devices. For 
example, some solid colors may need different CMYK definitions on different output devices. You 
can use the Update Styles from Palette button in the Plot Appearance (CFG) dialog box to update 
the styles in the CFG to use the definitions in a device-specific style palette. 
 

Setting the Default Location for Style Palettes 
To set the default location for style palettes: 

1 Click Settings on the M-Color menu in AutoCAD 

2 Click the Directories tab. 

3 Select PAL as the File type. 

4 Select the default location for PAL files under Default directory. 

5 Click OK. 

Setting the default location of style palettes does not prevent using files from other locations. The 
default location is just the default starting point for Open and Save As operations. 
 

Setting the Default Style Palette 
To specify the default style palette: 

1 Click Settings on the M-Color menu in AutoCAD 

2 Click the Directories tab. 

3 Enter the full path of the default style palette file under Default file or click Browse to select 
the file. 

4 Click OK. 
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 Setting the default style palette is actually meaningful only if you work with drawings 
created by previous M-Color versions. In the current M-Color version, M-Color always uses the 
most recently used style palette as the default. Because the style definitions are stored also in the 
CFG file, the “current palette” has no effect on the output. 
 

Color Differences between Output Devices 
Different output devices may produce colors very differently. This is due to the differences in the 
technology and inks they use. The difference is especially clear between monitors and printers. 

The color management system of M-Color helps you to avoid the problems with color deviations 
between different monitors and printers. See Color Management for more information. 
 

Pantone Color Palettes 
M-Color comes with two Pantone color palettes that contain the definitions of the industry 
standard Pantone Matching System® (PMS) and Pantone® Process colors. 

Pantone Process Color System 

The Pantone Process Color System defines hundreds of industry-standard color definitions. In M-
Color, the Pantone Process colors can be found in the Pantone Process Color System.pal file. 

The advantage of using the Pantone Process colors is that they allow you to achieve perfect color 
matching results when printing your drawings at a print house. Print houses tune their equipment 
to produce the Pantone Process colors as closely to the standard as possible. You can purchase a 
printed color guide called the Pantone Process Guide that acts as the accurate ink-on-paper 
reference for choosing Pantone Process colors. 

Pantone Matching System (PMS) 
The Pantone Matching System defines hundreds of industry-standard color definitions. In M-
Color, the Pantone Matching System colors can be found in the Pantone Matching System.pal file. 

Unlike the Pantone Process colors, PMS colors cannot usually be accurately reproduced with the 
CMYK color system. The genuine use of PMS colors would require producing a separate print 
film for each PMS color in the drawing and the use of special PMS inks. 

Internally, M-Color uses the sRGB and CMYK color systems to define colors. Thus, the PMS 
color palettes do not really represent the genuine PMS colors but only their closest generic CMYK 
equivalent. Because of this, accurate matching cannot necessarily be achieved. 

Using the Pantone Process Color System instead of PMS is recommended. Use PMS only if you 
have a specific reason, and be aware of the limitations of the CMYK color system in reproducing 
PMS colors. 
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Printing Style Palettes 
You can print any of M-Color's style palettes so that you can use the printed palette as a reference 
when picking colors. 

For optimal results, you should calibrate your monitors and printers before printing style palettes. 
See Color Management for more information. 

To print the style palette: 

1 Use the Manage Palettes command and open the style palette you want to print. 

2 Click Print Palette in the Manage Palettes dialog box. 

3 M-Color prompts you for the name of an MCL file. The style palette will be saved to this 
MCL. 

4 Once you have specified a name for the MCL file, M-Color will create the MCL file and open 
it in M-Color Preview. You can print the style palette drawing just as any other M-Color 
drawing. 

 

Color Management 

Overview 
Achieving consistent color output and good screen-to-print color matching is of key importance to 
most M-Color users. The color management system of M-Color can help you to solve the 
traditional problems with color deviations between different monitors and printers. 

Monitors and printers use fundamentally different techniques to produce colors: monitors typically 
use red, green and blue lights (additive color method), while printers use cyan, magenta, yellow 
and black inks (subtractive color method). In addition, there are surprisingly big variations 
between the colors from different printers, even from the same manufacturer. Ink brand, media 
type, as well as printer and printer driver settings affect color output. This results in the all too 
common problem: colors on screen do not match printed colors, and color output from different 
printers varies too much. 

M-Color tries to hide most of the color management complexity from you so that you can 
concentrate on your real work. However, you will benefit from understanding the main concepts 
and ideas behind color management because this helps you avoid some of the most common 
misunderstandings. 
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Color Gamut 
One of the first things you need to understand is that there are lots of colors that can be displayed 
on monitors but cannot be printed. Monitors can typically display bright colors that are simply 
impossible to produce with the ink system used by printers. That is, you may define and see a very 
bright green color on your monitor (such as sRGB 0, 255, 0), but no printer in the world is capable 
of accurately reproducing this same color on paper. 

The consequence is that if you want screen colors and printed colors to match, you must restrict 
your color choices to those colors that can be produced on both monitors and typical printers. M-
Color helps you in this by hiding non-printable colors in color definition by default. 

The range of colors a device can produce is called the gamut of the device. 
 

Color Profiles 
Another important thing to realize is that all monitors and printers are different. They have big or 
small differences in how they produce colors. If these device-specific differences are not taken into 
account in color printing, you cannot expect perfect color matching results. 

M-Color uses industry-standard ICC color profiles to compensate for device-specific differences in 
color output. The color profile of a device tells M-Color what kind of color adjustments are 
required to get this device to output the desired colors. The color profile also tells M-Color the 
gamut of the device (the range of colors that the device is capable of producing). 

To manage the color profiles of your monitor and printers, use the Color Management command 
on the File menu in M-Color Preview. 
 

Color Spaces and Device-independent Colors 
There are several ways to define colors. Most users are familiar with names of at least the RGB 
and CMYK color spaces. However, RGB and CMYK color spaces are actually device-dependent. 
For example, a CMYK color 100, 0, 0, 0 only defines that the printer should use 100% cyan ink 
coverage and no other inks. But since the cyan ink tone itself has not been standardized, two 
different printers will most likely produce a somewhat different color with these color values. 

To avoid this problem, M-Color defines all colors in a device-independent way. The primary color 
space used by M-Color internally is sRGB. 

sRGB 

The sRGB color space is based on an international standard (IEC 61966-2-1) and is device-
independent because it defines color values in the context of a “standard monitor”. 

Generic CMYK 

The CMYK color space as such is not device-independent. However, M-Color interprets all 
CMYK colors according to the characteristics of a Generic CMYK Printer. The principle is the 
same as in sRGB: by standardizing the characteristics of the device, the colors defined in this color 
system become stable. 
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HSB 

The HSB color space (hue - saturation - brightness) is actually not a color space of its own but just 
a different convention for expressing RGB color values. In M-Color, HSB colors are based on the 
sRGB color space. 
 

Monitor Calibration 
All monitors are different. Just changing the brightness, contrast and color temperature settings of 
your monitor affects on-screen colors considerably. Modern monitors with reasonable settings 
typically produce fairly accurate colors. Unfortunately, it is very difficult or impossible to say 
whether your monitor currently displays correct colors or not. The only way to guarantee that you 
are seeing the right colors on your monitor is to calibrate it using a special instrument. 

In order to reliably calibrate your monitor, you need an optical sensor that measures the colors that 
your monitor produces. Such a device and its accompanying software calibrate your monitor and 
create an ICC color profile that enables M-Color to display accurate colors. 

Monitor calibration devices are very affordable - the cost is typically less than $200 and you can 
use the same device to calibrate as many monitors as you want. Contact us at support@m-
color.com for recommendations. 
 

Printer Calibration 
There are considerable variations between printers in how they output colors. If printed colors do 
not match the colors you see on your monitor, or if some of your printers produce different colors 
than the others, you need to obtain an ICC color profile for your printer. A color profile enables 
M-Color to make device-specific adjustments to color values so that the color output from the 
device matches the real target colors. 

Some printers come with predefined ICC color profiles. You can try using these color profiles to 
see if they improve the color output. However, for the best possible results, you need to obtain a 
custom color profile. 

The creation of a custom profile for your printer involves printing a few specialized test prints with 
your printer and sending them to a company that measures the prints and creates an ICC color 
profile for your printer. The typical cost of a printer color profile is $99. Contact support@m-
color.com to get your printer profiled. 

One of the benefits of profiling your printer is that the ICC color profile tells M-Color the range of 
colors your printer can produce (= the gamut of your printer). Using this information, M-Color 
helps you to avoid color-matching problems by masking unprintable colors in the color definition 
dialog box. 

Once you have calibrated your monitors and obtained color profiles for your printers, M-Color 
knows exactly how colors need to be adjusted for each of your devices and you can enjoy 
consistent, predictable color output. 
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Colors in PDF and PostScript Formats 
M-Color lets you save your work in a number of formats, including PDF and PostScript. When 
you save an MCL file to PDF or PostScript format, you can define the way color data is saved. 

In most cases, you should use the default color setting, Standard RGB (sRGB). When this setting is 
used, M-Color writes all color values to the PDF or PostScript file in the sRGB color space. The 
information about the used color space is also saved to the file. This enables the target application 
or device such as Adobe Acrobat Reader or a PostScript printer to interpret colors correctly. 

When you view sRGB PDF files in Adobe Acrobat, Acrobat uses similar techniques as M-Color to 
adjust colors for display and printing according to the devices' color profiles if available. This 
results in consistent color output: you get the same colors on screen and on paper regardless of 
whether you are viewing MCL files in M-Color Preview or sRGB PDF files in Adobe Acrobat. 

In some special cases, you may want to select CMYK color output instead of sRGB color output 
when saving your work to PDF or PostScript format. For example, if you want the literal CMYK 
values you have used in color definition in M-Color to be written to the PDF or PS file, you should 
select CMYK as the color mode when saving to PDF or PostScript. However, in most cases, the 
preferred color mode for PDF and PostScript is sRGB. 
 

Colors in Bitmap Exporting 
When exporting your work into a bitmap format such as TIFF or JPEG, you can choose between 
two color modes: RGB (current display colors) or Standard RGB (sRGB). If you select RGB 
(current display colors), M-Color will write the same RGB color values to the bitmap file as are 
sent to your display driver. This is the default mode and works well if you intend to use the bitmap 
file on the same computer in a Word document or in a PowerPoint presentation, for example. 

If you intend to publish the picture on the Internet or send it to other users via e-mail, you should 
use the sRGB color mode. In this mode, M-Color writes standardized sRGB color values to the 
bitmap file, making it more portable. Using sRGB in Internet use works especially well because 
web browsers typically assume that all bitmaps on web pages are in sRGB color format. 
 

Recommendations 
By following these recommendations you can enjoy consistent color output throughout your M-
Color workflow: 

 Calibrate your monitor. 
 Standardize your printer driver settings and obtain custom ICC color profiles for your printers. 
 Whenever any part of your printing process changes, check color output and obtain a new 

color profile if necessary. Factors that affect color output include operating system version, 
printer driver version, printer driver settings, media type and ink brand. 

 Use the sRGB color mode when saving to PDF and PostScript formats and when exporting to 
bitmap formats. 
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Working with Text and Fonts 

Adding Text to Your Drawing 
To add text to your drawing, simply add text objects to your AutoCAD drawing using the normal 
AutoCAD commands (TEXT and MTEXT, for example). 

You can use any SHX or TrueType fonts when adding text in AutoCAD. M-Color supports all 
these fonts. 

M-Color enhances text quality by automatically replacing standard AutoCAD SHX fonts with 
high-quality TrueType and Adobe Type 1 fonts. 

For more information about text and fonts, see the following chapters. 
 

Ensuring Your Text Is not Hidden Under Filled Objects 
When using filled objects and text in the same drawing, it is important to ensure that the text 
objects are not hidden under filled areas. In M-Color, this is solved by controlling the plotting 
order of layers. 

To ensure that your text is not hidden under filled objects, always place text objects on different 
layers than the filled objects. Then, in the Plot Appearance dialog box in M-Color, adjust the 
plotting order of layers so that text layers are above the layers with filled areas. 

See Changing the Plotting Order of Layers for more information. 
 

Using Fonts 
Using fonts is an important way to enhance the appearance of your drawing. M-Color supports all 
SHX, TrueType and Adobe type 1 fonts, which allows you to use any font you currently have 
installed on your system. 

To create a text using a specific font, no special steps are required. Simply create a text style using 
that font in AutoCAD, and draw your text using that text style. This way you can use any 
Windows font. 

Another important aspect in using fonts is the speed. In AutoCAD drawings, keeping regen times 
fast is very desirable. Excessive use of TrueType fonts can quickly slow down the regens, which in 
turn reduces productivity. Using SHX fonts is much more efficient, but they do not look as good as 
TrueType fonts when printed. 

M-Color solves the problem by allowing you to map SHX fonts to TrueType and Adobe Type 1 
fonts. M-Color substitutes the SHX fonts with Windows fonts during plotting, thus giving you the 
high-quality appearance of Windows fonts on your plots. Font substitution does not affect the 
AutoCAD drawing, so your regen times remain fast. See Mapping SHX Fonts to TrueType and 
Adobe Type 1 Fonts for more information. 

While substituting SHX fonts with TrueType or Type 1 fonts, M-Color retains the original length 
of the text objects by applying a length correction. This ensures your text looks the same as in the 
original drawing, but uses a better-looking font. See Maintaining the Length of Text Objects for 
more information. 
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Mapping SHX Fonts to TrueType and Adobe Type 1 Fonts 
M-Color can automatically substitute the SHX fonts in your drawing with high-quality TrueType 
and Adobe Type 1 fonts at plot time. This preserves the fast regens in AutoCAD, but gives great 
text quality when printed. 

By default, M-Color maps the standard AutoCAD SHX fonts such as txt.shx, romans.shx, 
isocp.shx, romant.shx etc. to Arial and Times New Roman fonts. 

If there is no mapping from a certain SHX font to a TrueType or Type 1 font defined in M-Color, 
M-Color will draw the texts using that exact SHX font (that is, as graphics). In this case, the line 
width will affect the appearance of the text. 

To control the font mappings from the SHX fonts of AutoCAD to TrueType or Type 1 fonts in M-
Color, select Edit Font Mappings on the M-Color menu in AutoCAD. The Edit Font Mappings 
dialog appears. 

The Font Mappings tab displays all font mappings made between SHX fonts in AutoCAD and 
corresponding fonts in M-Color. 

To edit a font mapping between an SHX font of AutoCAD and a TrueType or Type 1 font in M-
Color: 

1 Select the font mapping in the list of font mappings. 

2 Click Change Font in M-Color. 
3 Select the font that should replace this SHX font in M-Color plotting. 

4 Click OK. 

If an SHX font of AutoCAD is not displayed in the list of font mappings, you may add a mapping 
as follows: 

1 Click Add AutoCAD Font. 
2 Define the full path of the SHX font file (For example, C:\Program Files\AutoCAD 

2004\Fonts\isocp.shx) 

3 Edit the added mapping as instructed above. 

To remove a font mapping from the list, click Delete. When there is no mapping for an SHX font 
of AutoCAD, M-Color draws the SHX font as graphics. 

For information about the Width Adjustment field in the list, see Maintaining the Length of Text 
Objects. 

To reset the font mappings to M-Color defaults, click Reset to Defaults. Note that all custom 
changes made in the mappings will be lost.   

The Fonts in Current Drawing tab displays the font mappings affecting the active drawing. The 
AutoCAD Style column displays the AutoCAD styles used in the drawing. The other columns 
display the effective mapping. The information is not editable and all modifications must be made 
using the Font Mappings tab. 

See Edit Font Mappings command for more information. 
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Maintaining the Length of Text Objects 
When M-Color substitutes the SHX fonts with TrueType fonts, the length of text objects in your 
drawing would normally change. Yet, this is not desirable, because it can spoil the text positioning 
and alignments in your drawing. 

M-Color solves this by applying a length correction to the text objects. Although the font is 
changed during plotting, M-Color will retain the length of the text objects. This happens by 
default. 

Although generally very useful, text length correction may sometimes degrade text quality. This 
can happen when big length corrections need to be applied. M-Color must stretch the character 
widths and add extra spacing, which may make the text look worse than a natural font. 

You can turn off the text length correction individually for each font by repeating the following 
steps in the Edit Font Mappings dialog: 

1 Open the Font Mappings dialog by clicking Edit Font Mappings on the M-Color menu in 
AutoCAD 

2 Select the font mapping in the list of font mappings. 

3 Turn off Width Adjustment. 
4 Apply changes by clicking OK. 
 

Tips for Making Your Text Look Better 
Here are some tips that can help enhance the appearance of text objects in your drawing: 

 Use TrueType fonts for headlines 
 Define TrueType substitutes for all SHX fonts that you are using in your drawing. 
 Do not use very wide SHX fonts (txt.shx, for example). Big length corrections will degrade 

text quality. Instead, use narrower fonts such as Romans.shx with a width factor of 0.8. 
 Do not use SHX fonts that are filled with “hatching”. Use TrueType fonts instead or define 

mappings from SHX fonts to TrueType. 
 Control text color by setting the outline style of its layer in the Plot Appearance dialog box of 

M-Color. 
 Add drop shadows to your text layers to add depth to your drawing. 
 Use a translucent, gradient or bitmap texture style as the outline style for a text layer to create 

special effects. 
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Working with Raster Images 

What is a raster image? 
A raster image is a picture which is stored in bitmap format such as TIFF, GIF, BMP or JPEG. It 
consists of pixels, each of which has a certain color. Raster images commonly used with M-Color 
are scanned maps, photos, company logos and aerial photography. 

 As opposed to raster images, the lines, polylines, circles and texts in the drawing make up 
a vector drawing. 

M-Color can plot raster images with the AutoCAD drawing. 
 

Adding Raster Images to Your Drawing 
You can add scanned maps, scanned photos or any other raster images to your drawing. M-Color 
will automatically plot all raster images that have been added to the AutoCAD drawing.  

You can use both monochrome (black and white) and color images. Monochrome images will plot 
with the color that is specified as the outline style for their CFG layer in M-Color. Color images 
will naturally plot using their own color definitions. You can make the background of raster 
images transparent in M-Color. You can also make the entire raster image partially transparent so 
that the background still shows through. 

You can add raster images in AutoCAD by using the IMAGEATTACH command. M-Color can 
also plot images added by any 3rd-party raster application if it conforms to the AutoCAD R14 
IMAGE standard. This includes Autodesk Raster Design (formerly CAD Overlay), GTXRaster 
CAD, Hitachi, Rasterex, Tessel CADRaster and most other raster applications. 
 

Setting the Color of a Monochrome Raster Image 
The color of a monochrome (black and white) can be set using M-Color. The color of the image is 
controlled by the outline style setting of its CFG layer in the Plot Appearance dialog box. 

See Setting an Outline Style to a Layer for more information. 

A monochrome raster image is automatically “transparent” in M-Color. This means you can see 
any color fills or other objects that are under the monochrome raster image through the white 
(“empty”) areas of the raster image. 
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Using Color Raster Images 
You can use color images such as photos or aerial photography with M-Color. You can add them 
to your drawing as any other raster images. See Adding Raster Images to Your Drawing for 
more information. 

The color images will always be plotted using their own colors. The fill style or the outline style 
settings of the CFG layer do not affect color raster images. However, it is possible to define that 
the background of a raster image (such as the background of a tree image) should be transparent. 
You can also make the entire raster image partially transparent so that the background still shows 
through. See Partially Transparent Raster Images for more information. 

The plotting order of color raster images is defined by the plotting order of CFG layers, just as 
with any other objects. See Changing the Plotting Order of Layers for more information. 

Adjusting the Transparency of a Raster Image 
M-Color allows you to make the background of raster images transparent. In addition to this, you 
can use translucent fills on top of raster images and see the raster images through the translucent 
fills. The appropriate method of using the transparency and translucency features of M-Color 
depends on your purpose. 

 When using monochrome raster images, place the color fills under the raster image layer. 
You do not need to use translucent fills in this case. You will see the color fills through the white 
areas of the raster image. 

 When using color raster images such as aerial photographs, place the color fills on top of 
the raster image layer and define a translucent fill style for the color fills layer. This allows you to 
see the aerial photograph through the color fills. 

 When adding images of trees or people to architectural elevation drawings, make the 
background of the raster image transparent. When the background of the raster image (e.g. tree) is 
transparent, it does not obscure the building as it would if it was not defined transparent. 

 Contact Motive Systems or your M-Color reseller for information on purchasing 
collections of tree and people imagery for elevation drawings. 

Monochrome (black and white) raster images are automatically transparent in M-Color. That 
means you can always see through the white parts of monochrome raster images. 

Grayscale and color images are not transparent by default. This means that by default the whole 
image is fully opaque and all objects behind the raster image are obscured by the raster image. To 
avoid this, you can tell M-Color that parts of the grayscale or color image should be transparent. In 
AutoCAD, select the raster image and use the TRANSPARENCY command or modify the 
properties of the image and set the Transparency property to Yes. 

When the image has been defined transparent in AutoCAD, parts of it will appear transparent in 
M-Color if M-Color is able to recognize some kind of transparency area definition for the image. 
M-Color supports the following ways of defining which parts of  

 Alpha channel (a transparency channel) in TIFF files, for example. 
 Transparency color defined in GIF files. 
 Transparency color defined in Autodesk Raster Design or CAD Overlay. 
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The Alpha channel method is preferred because it is the most flexible way of defining 
transparency. Note that M-Color 9 supports 8-bit alpha channels to allow you to add photos that 
blend into your drawings. 

If you are not familiar with how to work with Alpha channels, you can use the “white pixels 
transparent” command in M-Color Preview. This is a very easy-to-use way of defining 
transparency for grayscale and color images. First, ensure that those pixels of your image that you 
want to make transparent are pure white (RGB 255, 255, 255). Then, use the Edit / Raster Images 
command in M-Color, select the raster image, and turn on the “White pixels transparency on” 
option. M-Color will make all white pixels of the selected image transparent. 
 

Partially Transparent Raster Images 
You can adjust raster images to be partially transparent. Use the Transparency setting in the 
Effects dialog box to adjust the transparency of raster images on a layer. 
 

Adding Translucent Color Fills on Top of Raster Images 
You can make the color fills on top of a raster image translucent and thus see the raster image 
through the color fills. This is very useful when using aerial photographs, for example. You can 
highlight specific areas with translucent color fills, while still allowing the information in the raster 
image to be seen. 

 When using color raster images such as aerial photographs, place the color fills on top of 
the raster image layer and define a translucent fill style for the color fills layer. This allows you to 
see the aerial photograph through the color fills. 

 When using monochrome raster images, place the color fills under the raster image layer. 
You do not need to use translucent fills in this case. You will see the color fills through the white 
areas of the raster image. 

For information on how to make parts of grayscale and color images transparent, see the previous 
topic. 
 

Changing the Plotting Order of Raster Images 
The plotting order of raster images is defined by the plotting order of CFG layers, just as with any 
other objects. See Changing the Plotting Order of Layers for more information. 

In general, when using monochrome raster images such as scanned maps, you should place color 
fill layers under the raster image layers, and text and line layers above the raster image layers in 
the Plot Appearance dialog box in M-Color. 
 

Correcting the Appearance of an Inverted Raster Image 
If a monochrome raster image appears negative in M-Color Preview, you can correct its 
appearance by inverting it: 

1 Click Raster Images on the Edit menu in M-Color Preview 

2 Select the raster image which you want to invert 

3 Click the Inverted option. 
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4 Click OK. 

 Inverting is only available for monochrome raster images. 
 

Getting Information about a Raster Image 
To get information about the raster images in the current drawing: 

1 Click Raster Images on the Edit menu in M-Color Preview. 

2 Select the raster image about which you want information. 

3 M-Color Preview displays the raster image dimensions, color depth, rotation and 
uncompressed size in memory in the dialog box. 

Supported Raster Image File Formats 
M-Color supports all common raster image file formats. This includes 

 BRK Brooktrout 
 BMP Microsoft Windows Bitmap 
 CAL CALS Raster 
 CG4 CALS Group 4 
 CUT Dr. Halo 
 DIB  Microsoft Device Independent Bitmap 
 DCX DCX 
 ECW ERMapper Compress Wavelets 
 G4  GTX Group 4 
 GP4  CALS Group 4 
 GIF  Graphics Interchange Format (CompuServe) 
 ICO  Icon resource file 
 IFF  Electronic Art's Interchange File Format 
 IMG GEM Raster 
 ICA  Image Object Content Architecture 
 JPG  JPEG File Interchange Format 
 JP2  JPEG2000 
 MAC Macintosh Paint 
 MSP MS Paint 
 PBM Portable Bitmap File Format 
 PCD Kodak Photo CD 
 PCX PC Paintbrush File Format 
 PGM Portable Graymap File Format 
 PCT Macintosh PICT 
 PNG Portable Network Graphics 
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 PNM Portable Any-Map File Format 
 PPM Portable Pixmap File Format 
 PSD Adobe Photoshop 
 RAS Sun Raster Data Format   
 RLC Run-length Encoded File (CAD Overlay) 
 RLE Run-length Encoded File 
 SGI  SGI Image File Format 
 SID  Multi-resolution Seamless Image Database (MrSID) 
 TGA Truevision Targa 
 TIF  Tagged Image File Format (includes all TIFF subformats) 
 XPM X PixMap 
 XWD X Window Dump 

See the next topic for recommendations regarding raster image file formats. 
 

Recommended Raster Image File Formats 
Although M-Color supports all common raster image file formats, you should generally use the 
following file formats. They provide the best speed, compression and portability:  
  

Monochrome images (black and white images): 

 TIFF CCITT Group 4 

Color images:  

 JPEG 

For aerial and satellite imagery: 

 ECW, MrSID 
 

Tips for Making Your Drawings Plot Faster 
Raster images are usually the factor that has the biggest effect on the plotting time. Although M-
Color can process raster image data very efficiently, printer drivers can be very slow when 
handling large amounts of raster data. Also, big raster images in the drawing may require large 
amounts of memory when printed. 

The speed of raster image plotting and the memory requirements greatly depend on the printer 
driver. Processing dozens of megabytes of raster data with M-Color is a matter of seconds so it is 
usually the printer driver that suffers from large images. 

In any case, you should follow these guidelines to keep your raster images reasonable in size and 
to achieve good results in printing time. 
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Monochrome (black and white) images: 
 Keep the density of the raster file reasonable. Recommended value is 200 dpi. Do not use a 

greater value than 400 dpi. 
 Check the dimensions of the raster image file. A reasonable size of an E-size scanned map is 

under 7000 x 9000 pixels. A reasonable size for an A-size scanned map is under 2500 x 3500 
pixels. 

 Make sure your monochrome raster image is really saved in monochrome (1-bit) format and 
not as a color image. 

 Avoid rotating the raster image in other than 90-degree steps. Rotating the raster image data in 
the original raster file itself is recommended so that you can add the raster image in M-Color 
with an orthogonal rotation angle. 

Color images: 

 Keep the density of the raster file reasonable. Recommended value is between 100 dpi and 
200 dpi. 

 Avoid rotating the raster image in other than 90-degree steps. Rotating the raster image data in 
the original raster file itself is recommended so that you can add the raster image in M-Color 
with an orthogonal rotation angle. 

 

Using M-Color Plots in Other Applications 

Copying and Pasting as an OLE Object 
You can copy the M-Color plot onto the Windows clipboard, and further paste it in any other 
Windows application, such as Microsoft Word, Microsoft Excel, Microsoft PowerPoint, Corel 
WordPerfect etc. 

To copy the M-Color plot onto the Windows clipboard: 

1 Open the drawing in M-Color Preview. 

2 Click Copy to Clipboard on the Edit menu. 

3 Set the size, colors and resolution and click OK. 

4 M-Color copies the drawing onto the clipboard. You can now switch to another application 
and paste the M-Color plot using the Paste command on the Edit menu in the target 
application. 

 The M-Color plot is transferred in bitmap format. 

 You can also export the M-Color drawing to a bitmap file and import the bitmap file into 
the target application. See Exporting to Bitmap File Formats for more information. 
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Exporting to Bitmap File Formats 
You can export the M-Color drawing to a bitmap file format and further import the resulting 
bitmap file into other applications. 

To save the M-Color plot to a bitmap file format: 

1 Open the drawing in M-Color Preview. 

2 Click Export on the File menu. 

3 Select the output file format using the Save as type combo box. 

4 Enter the bitmap file name. 

5 Click Save. 

6 The Export - Format Options dialog box appears. 

7 Define appropriate size and other parameters for the bitmap image and click OK. 

 In the Export dialog, set the Color space option to RGB (current display colors) if you 
wish to export the bitmap using the exact color values that are displayed currently on screen. 
Select Standard RGB if you wish to store the color value in a standardized format. See the topics 
under Color Management for more information. 

See the Export command for more information. 
 

Producing an Adobe Acrobat PDF File 
You can produce an Adobe Acrobat PDF file using M-Color. PDF files are very suitable for 
sharing documents with other users on a company Intranet or the Internet. 

To produce an Adobe Acrobat PDF file: 

1 Open the MCL file in M-Color Preview. 

2 Click Publish to PDF on the File menu. 

3 Specify PDF options, or just click Continue to accept the default options. 

4 Specify the name of the target PDF file. 

See the topics under Color Management for more information about the colors included in the  
PDF document. 
 

Producing a PostScript File 
M-Color lets you save your drawings in PostScript (PS) and Encapsulated PostScript (EPS) 
formats. However, PDF files are more versatile and offer better performance compared to 
PostScript files so use the PDF format if possible. 

To produce a PostScript or EPS file: 

1 Open the MCL file in M-Color Preview. 

2 Click Publish to PostScript on the File menu. 
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3 Specify PostScript options, or just click Continue to accept the default options. 

4 Specify the name of the target PostScript file. 

You can create a PostScript plot file also by printing to file using a PostScript printer driver. 
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This chapter describes the menu commands that are available in M-Color in AutoCAD and in M-
Color Preview. 
 

M-Color menu commands 
The M-Color menu in AutoCAD offers the following commands: 

Plot Appearance (CFG) Modifies the fill style, outline style and outline width settings of 
objects. 

Set Paper Specifies the size and positioning of the M-Color paper frame (plot 
area) in the AutoCAD drawing. 

Preview and Plot Plots the current drawing to a preview file. 

Manage Palettes Modifies the style palettes, allowing addition of new styles or 
modification of existing ones. 

Tools / Create MPolygon Creates a new MPolygon object that can contains multiple loops 
and holes (islands). 

Tools / Edit MPolygon Adds, deletes or moves the boundaries of an MPolygon object. 

Tools / Import AutoCAD 
Color Book 

Converts an AutoCAD Color Book into an M-Color Style Palette. 

Settings Modifies M-Color settings. 

Edit Font Mappings Modifies the mappings between the SHX fonts of AutoCAD and 
the TrueType/Type 1 fonts in M-Color. 

M-Color Help Shows M-Color Help. 

About M-Color Shows information about the current M-Color version. 

 
 

C H A P T E R  5  

COMMAND REFERENCE 
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Plot Appearance (CFG) command 
Use this command to edit the Plot Appearance configuration (CFG file) of the drawing. The CFG 
file defines fill styles, outline widths and outline styles for the objects in the drawing. See The 
Principles of Plot Appearance Settings (CFG Files) and Working with Plot Appearance 
Configurations (CFG Files) for more information. 

When you click this command, the Plot Appearance dialog box appears: 

 
Title Bar 
The title bar shows the name of the CFG file currently being edited. 

Select CFG Layers 

Lets you select CFG layers based on flexible criteria. For example, you can define that you want to 
select all CFG layers that have a translucent fill style. 

For more information, see Select CFG Layers Dialog Box. 

Invert Selection 

Deselects all CFG layers that are currently selected, and selects all CFG layers that were not 
selected. 

Layer List 
The list box shows the list of CFG layers in the CFG file. 

Each CFG layer two properties that define the criteria for selecting the objects that follow the 
settings of this CFG layer: Layer Name Condition and Color Index Condition. 

Each CFG layer has four properties that define the appearance of the objects that follow the 
settings of this CFG layer: Fill Style, Width, Outline Style, and On/Off State. 
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The second line width value (under the Act. column heading) shows the actual line width that will 
be used when printing the drawing. It is usually the same as the left line width value but may be 
different if the Scale of the outline width option is active in the Plot Appearance - Options Dialog 
Box. 

The Time column displays the processing time of the layer in printing. The value is displayed only 
after the MCL document has been printed. This column helps you to find the most complex layers 
in the style definitions. 

Layer Name and Color Index 

Changes the layer name and color index conditions of the selected CFG layers. 

For more information, see Define Object Property Criteria Dialog Box. 

Fill Style 

Changes the fill style of the selected layers. 

For more information, see Select Style Dialog Box. 

Width 

Changes the outline width of the selected layers. 

Outline Style 

Changes the outline style of the selected layers. 

For more information, see Select Style Dialog Box. 

Effects 

Changes the effects of the selected layers. 

For more information, see Effects Dialog Box. 

Add CFG Layer to List 
Adds one or more new CFG layers to the list. 

For more information, see New CFG Layer Dialog Box. 

Remove CFG Layer from List 
Removes the selected CFG layers from the list. 

Options 

Manage plot scale of line widths, the behaviour of XREF drawings and object processing. For 
more information, see Plot Appearance - Options Dialog Box. 

Update Styles from Palette 

Allows you to update the styles in the CFG to use the definitions of a specific style palette. The 
styles in the CFG are updated based on their name. For every style used in the CFG, M-Color 
searches for a style with the same name in the style palette you select. If a match is found, the style 
in the CFG is updated to use the style definition set in the style palette. Styles that do not have a 
matching style in the style palette are not changed. 

Update Screen (only in M-Color Preview) 
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Updates the drawing being previewed to use the current settings in this CFG file. The changes are 
only temporary until you click the OK button to close the Plot Appearance dialog box. 

Auto-Update Screen (only in M-Color Preview) 

Enables or disables automatic screen updating after each change made to the CFG file. 

New CFG 

Starts a new, empty CFG file. 

Open CFG      

Opens an existing CFG file. 

Import      

Import AutoCAD's pen settings (PCP/PC2) or color based plot style table (CTB) file as a new 
CFG. 

Save CFG As 

Saves the current CFG file with a new name. 

Print CFG 

Produces an MCL file that shows the contents of the current CFG file. You can print the created 
MCL file as any other M-Color drawing. 

OK 

Saves the current CFG file and closes the Plot Appearance dialog box. Updates the drawing being 
previewed to use the settings of the modified CFG file. If in AutoCAD, the changes are saved 
directly to the CFG file on disk. If in M-Color Preview, the changes are not saved to the CFG file 
on disk until you save the MCL document. 

Cancel 
Discards the changes made to the CFG file and closes the Plot Appearance dialog box. 
 

Plot Appearance - Options Dialog Box 

Use this dialog to modify the options of the Plot Appearance configuration that affect the plotting 
of layers. 
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Ignore XREF prefixes in AutoCAD layer names 

Defines if M-Color should ignore the XREF drawing name prefixes in AutoCAD layer names 
when matching AutoCAD layers to the layer name conditions of CFG layers. The XREF prefix is 
the name of the XREF drawing, followed by a | (“pipe”) character. When this option is on, the 
CFG layer settings apply to the layer with that name in the main drawing as well as all XREFs. 
When this option is off, you need to specify separate CFG layer entries for the main drawing layer 
and XREF layers or use wildcards. 

If object matches multiple CFG layers 

If an AutoCAD object matches the conditions of multiple CFG layers select Plot all (default) to 
plot all the matching layers on the object, Plot topmost only to plot only the highest matching CFG 
layer in the layer list on the object and Plot bottommost only to plot the lowest matching CFG 
layer in the list on the object. 

Scale of the Current Drawing 

Shows the scale of the current drawing as defined in the Set Paper dialog box in M-Color. 

Scale of the Outline Widths 

The plot scale in which the line widths in the CFG file have been defined. The Active button next 
to Scale of the Outline Widths edit box defines whether the setting is in effect or not. 
 

Define Object Property Criteria Dialog Box 

When you click the Layer Name and Color Index button in the Plot Appearance dialog box, the 
Define Object Property Criteria dialog box appears: 

 
In this dialog box, you define the criteria that AutoCAD objects must match in order to follow the 
settings of this CFG layer. 
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Layer Name 

Defines the layer name condition of this CFG layer. Only objects whose AutoCAD layer name 
matches this condition can follow the appearance settings of this CFG layer. 

The layer name condition can include wildcards. For example, setting the layer name condition to 
HOUSE* will match all objects on any layer that begins with the word HOUSE. 

Selecting Any is equivalent to entering * as the layer name condition. It matches all layer names. 

AutoCAD Color Index 

Defines the color index condition of this CFG layer. Only objects whose color in AutoCAD 
matches this condition can follow the appearance settings of this CFG layer. 

Selecting Any means that the object's AutoCAD color is ignored. 

Note that only objects that match both the layer name condition and the color index condition will 
follow the appearance settings of this CFG layer. For example, if the layer name condition is 
HOUSE_1 and the color index condition is Yellow (2), only yellow AutoCAD objects on the 
HOUSE_1 layer will follow the appearance settings of this CFG layer. 

To control the appearance of objects based on their AutoCAD layer only, you should set the color 
index condition to Any. 
 

New CFG Layer Dialog Box 

When you click the Add CFG Layer to List button in the Plot Appearance dialog box, the New 
CFG Layer dialog box appears: 
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In this dialog box, you define the layer name and color index condition of the new CFG layer you 
are creating. 

There are two ways to define the new CFG layer: You can manually define the layer name 
condition and color index condition for the new CFG layer by clicking the Define Layer Name and 
Color Index Conditions button. Or, you can pick one or more AutoCAD layers from the list of 
drawing layers. In the latter case, the AutoCAD layer name becomes the layer name condition of 
the new CFG layer, and the color index condition is set to Any. 

Define Layer Name and Color Index Conditions 

Opens the Define Object Property Criteria dialog box and lets you type the layer name condition 
and color index condition for the new CFG layer. Use this method if you want to use wildcards in 
the layer name condition or if you want to set the color index condition to something else than 
Any. 

Quick Insert of AutoCAD Layers 

You can pick one or more AutoCAD layers from the list of drawing layers. This will create one 
new CFG layer for each selected AutoCAD layer. The name of the AutoCAD layer becomes the 
layer name condition of the new CFG layer, and the color index condition of the new CFG layer is 
set to Any. 

You can use this method to quickly add one or more AutoCAD layers to the CFG. Note that in 
most cases you should not add all AutoCAD layers to the CFG. Instead, add only those layers that 
need special appearance settings, and let all other object be controlled by the ~Remaining_objects 
special layer. 

Filter 
You can select a predefined filter from the dropdown list, or define your own filter by clicking the 
... button next to the list. The selected filter affects the display of AutoCAD layers. Only those 
AutoCAD layers that match the conditions defined in the filter are displayed. 

For more information, see Filter AutoCAD Layers Dialog Box. 

Invert Filter 
Inverts the current filter. When Invert Filter is on, all AutoCAD layers that do not match the 
conditions defined in the filter are displayed. 
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Filter AutoCAD Layers Dialog Box 

When you click the ... button in the New CFG Layer dialog box, the Filter AutoCAD Layers 
dialog box appears: 

 
In this dialog box, you define filtering criteria for a custom filter. The filter is used to limit the 
display of AutoCAD layers in the New CFG Layer dialog box. 

Layer Name 

Defines the condition that the AutoCAD layer name must match. You can use wildcards *, ? And 
# like in the layer name condition of CFG layers. 

Specifying * matches all AutoCAD layer names. 

Layer Color 
Defines the color that the AutoCAD layer must have in order to match the filter. Specify a 
standard AutoCAD color index between 1 and 255. 

On / Off 
Allows you to filter layers based on their on / off state in AutoCAD. 

Frozen / Thawed 

Allows you to filter layers based on their frozen / thawed state in AutoCAD. 

Used / Not Used in AutoCAD 

Allows you to filter AutoCAD layers according to whether the layer has objects on it in AutoCAD 
or not. The layer is considered “used” if it has at least one object in AutoCAD. 

Added / Not Added to CFG 

Allows you to filter AutoCAD layers according to whether the AutoCAD layer name exists in the 
current CFG file or not. 

An AutoCAD layer is considered to exist in the CFG file only if the layer name condition of at 
least one CFG layer matches the name of the AutoCAD layer exactly. Wildcards are not taken into 
account. 
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Filter Name 

Allows you to specify a name for the filter. 

Save 

Saves the changes to the current named filter. 

Delete 

Deletes the current named filter. 

OK 

Closes the Filter AutoCAD Layers dialog box, saves changes to filters, and activates the current 
filter. 

Cancel 
Closes the dialog box and discards changes to filters. 

Reset 
Resets the current filter. 
 

Select CFG Layers Dialog Box 

When you click the Select CFG Layers button in the Plot Appearance dialog box, the Select CFG 
Layers dialog box appears: 

 
In this dialog box, you define the criteria for selecting CFG layers from the current CFG file. 
When you click OK, all CFG layers that match the defined criteria will be selected. 

The different condition fields are combined with AND logic. For example, if you define a fill style 
condition and an outline style condition, only those CFG layers that match both these conditions 
will be selected. 
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Layer Name Condition 

Allows you to select CFG layers based on their layer name condition text. For example, typing 
HOUSE* in this field will select all CFG layers whose layer name condition begins with the word 
HOUSE. 

Color Index Condition 

Allows you to select CFG layers based on their color index condition. Choosing Any will select all 
CFG layers whose color index condition is Any. Choosing a specific color index value will select 
all CFG layers with that color value as their color index condition. 

Fill Style 

Allows you to select CFG layers based on their fill style type. All layers whose fill style is one of 
the enabled style types will be selected. For example, turning on Solid and Gradient will select all 
CFG layers whose fill style type is either solid or gradient. 

Outline Style 

Allows you to select CFG layers based on their outline style type. All layers whose outline style is 
one of the enabled style types will be selected. For example, turning on Translucent and Gradient 
will select all CFG layers whose outline style type is either translucent or gradient. 

Number of Occurrences in CFG 

Allows you to select CFG layers based on the number of times they occur in the CFG. Typically, 
each CFG layer appears in the CFG file only once. However, there are cases when multiple 
occurrences of a CFG layer are desirable. 

A CFG layer is said to appear more than once in the CFG file if more than one CFG layer has 
exactly the same layer name and color index conditions. 

Choosing One will select all CFG layers that occur in the CFG file exactly once. 

Choosing Two or more will select all CFG layers that occur in the CFG file multiple times. This 
helps you eliminate duplicate CFG layers when they are not intentional. 

Effect on AutoCAD Objects 

Allows you to select CFG layers based on whether they affect some drawing objects or not. 

Typically, a CFG layer is meaningful for a drawing only if it controls the appearance of some 
objects. However, many CFG files contain unnecessary layers, perhaps as leftovers from previous 
editing sessions. For example, a CFG layer with layer name condition HOUSE_123 is not needed 
if the AutoCAD drawing does not even contain such a layer. Eliminating unused layers is easy 
with this selection condition. 

Choosing Affects some objects will select all CFG layers that affect the appearance of at least one 
object in the current drawing. 

Choosing Affects no objects will select all CFG layers that do not affect any objects in the current 
drawing. You can delete such CFG layers without changing the appearance of the drawing at all. 

Note that eliminating unused layers from the CFG is not always desirable. For example, if the 
same CFG file is used with multiple AutoCAD drawings, some CFG layers might not be 
meaningful for the first drawing but might still be required for the second drawing. 

OK 
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Closes the Select CFG Layers dialog box and selects all CFG layers that match the defined criteria. 

Cancel 
Closes the dialog box without making changes to the current selection. 

Reset 
Resets the selection conditions to their defaults. 
 

Select Style Dialog Box 

 For information on using the Manage Palettes dialog box, see Manage Palettes 
command. 

When you click the Fill Style or Outline Style button in the Plot Appearance dialog box, the Select 
Style dialog box appears: 

 
Style from palette 

The list box shows the styles in the currently loaded style palette. 

You can select a style from the list and click OK. 

If you want to make a modified style and use one of the styles in the palette as the base for that 
style, select a style from the list, click the right mouse button and select Copy to Custom Style. 

Show styles from palette 

The name of the currently loaded palette is displayed. You can change the current palette by 
selecting another recently used palette in the drop list or you can click the Browse button. 

Browse 

Displays the Open dialog box and allows you to specify the name of the style palette to load. 

Custom style 

A style that you can edit and use without saving it to any style palette. 
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If you want to make a modified style and use one of the styles in the palette as the base for that 
style, select a style from the list, click the right mouse button and select Copy to Custom Style. 

Edit 
Displays the Define Style dialog box and allows you to change the definition of the custom style. 

OK 

Closes the Select Style dialog box and uses the currently selected style (either from palette or the 
custom style). 

Cancel 
Closes the Select Style dialog box without making changes to the style selection. 

Manage 

Displays the Manage Palettes dialog box that allows you to add, modify and remove styles in style 
palettes. 

Copy to Custom Style 
Makes a new custom style based on the selected style from palette. 
 

Effects Dialog Box 

When you click the Effects button in the Plot Appearance (CFG) dialog box, the Effects dialog 
box appears: 

 
Drop shadow 

Select drop shadow effect and click Edit to edit its preferences. See Define Drop Shadow Dialog 
Box for more information. 

Hand-drawn effect 
Select hand-drawn effect and click Edit to edit its preferences. See Define Hand-drawn Effect 
Dialog Box for more information. 

Transparency of raster images 
Set the transparency of raster images on selected layer. 

 This setting does not control the transparency of bitmap textures. To change the 
transparency of a bitmap texture, see Bitmap Texture Style Dialog Box for more information. 
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Preview 
Preview window shows a sample of the currently selected effects and preferences. 
 

Define Drop Shadow Dialog Box 

 
Select fill style 

Select the fill style you want to use in the drop shadow. Only solid and translucent fills are 
available. 

Angle 
Set the angle where the shadow is casted. 
Distance 
Set the distance of the shadow from the object. 
Feathering 
With this option you can define how sharp or blended the shadow is. 
Import 
Select Import to load predefined or saved effect presets. 

Export 
Select Export to save your effect presets. 

Preview 
Preview window shows a sample of the currently selected effects and preferences. 
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Define Hand-drawn Effect Dialog Box 

Use the hand-drawn effect to add a touch of personality your drawings. This feature adds random 
deviations to the line segments to make your drawing look like it was hand-drawn. 

 
Name 

The name of the effect. 

Properties 
Properties show the order of the selected and available effect preferences. 

Move ends 
With move ends you can vary the start and end points of lines. This option also allows you to vary 
how many times a line is drawn. You can set maximum and minimum values for effect deviations. 
With move ends a simple drawing could look like this: 
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Curve 
The Curve option makes lines to curve a bit to the right and left. You can set maximum and 
minimum values for effect deviations. With curve a simple drawing could look like this: 

 
Deviate 
With the deviate option you can set the lines to deviate from the original line. You can set 
maximum and minimum values for effect deviations. With this option a simple drawing could look 
like this: 

 
Break 
The Break option makes gaps to the lines. You can set maximum and minimum values for effect 
deviations. With this option a simple drawing could look like this: 

 
Increase width at ends 
With this option the line width is increased at the ends of line segments so that line starts and ends 
are thicker. You can set maximum and minimum values for effect deviations. With this option a 
simple drawing could look like this: 
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Up and down arrows 
You can set the order of selected effects by moving them up and down. 
Defaults 
Sets the default values for this effect. 
Before 
Preview window shows a sample drawing with no effects applied. 
After 
Preview window shows a sample of the currently selected effects and preferences. 

Factor 
With this slider you can multiply the minimum and maximum values in the effect options. All 
values except number of lines are affected. 
Import 
Select Import to load a predefined or saved effect. 

Export 
Select Export to save your effect. 
 

Set Paper command 
Use this command to define the plot paper for the AutoCAD drawing. See Defining a Plot Paper 
for more information. 

When you click this command, the Set Paper dialog box appears: 
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Paper Size 

Select a standard paper size from the list or define a custom size by selecting the Custom Size 
paper size. 

Corners < 

Asks you to point the corner points of the paper from the AutoCAD drawing. 

Units (Paper Size) 

Sets the units used to display paper sizes in the list. 

Orientation 

Orientation of the paper (portrait or landscape). 

Rotation 

Rotation angle of the paper frame in the AutoCAD drawing. 

On Screen < (Rotation) 

Lets you define the rotation of the paper frame by moving the mouse pointer on the screen. 

Plot Scale 

Plotting scale of the drawing. Defines the true plotting scale, which is independent of any units. 
That is, 1:200 equally defines the plot scale to be 1 inch on paper for 200 inches in real world, as 
well as to be 1 millimeter on paper for 200 millimeters in real world. 

Fit Area to Paper < 

Lets you point an area from the AutoCAD drawing and changes the plot scale so that the area fits 
inside the current paper size. 

AutoCAD Drawing Units 

The drawing units you are using in the AutoCAD drawing. Defines how much one AutoCAD 
drawing unit in your AutoCAD drawing is in the real world. 

Paper Frame Positioning 

Defines the center point of the paper frame in the AutoCAD drawing. 

Point on Screen < (Paper Frame Positioning) 

Lets you point the desired center of the paper frame from the AutoCAD drawing. 

Zoom to Paper Frame 

Zooms the drawing so that the whole paper frame fits on the screen. 

Set as Defaults 

Sets the current paper size and properties as the default for all new drawings. 

OK 

Saves the changes made to the paper frame and closes the Set Paper dialog box. 

Cancel 
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Discards the changes made to the paper frame and closes the Set Paper dialog box. 
 

Preview and Plot command 
Use this command to plot the AutoCAD drawing to a preview file (MCL file by default). See 
Previewing the Drawing and Printing the Drawing for more information. 

During the plotting process, M-Color shows the following dialog box, which shows the status of 
the plotting process: 

 
AutoCAD drawing 

The name of the AutoCAD drawing being plotted. 

M-Color CFG file 

The name of the Plot Appearance configuration (CFG file) being used. 

Plot file 

The name of the plot file being produced. 

Status 

A status text describing the current phase of processing. 

Overall progress 

Indicates the percentage of completion of the plotting process. 

Preview 

Opens the plot file in the preview. Disabled until the plotting process is completed. 

Cancel 
Cancels processing. 
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Manage Palettes command 

 For information on using the Select Style dialog box, see Select Style dialog box. 

The manage palettes command allows you to edit style palettes. A style palette is a collection of 
predefined styles that you can use in your CFG files. See Working with Styles and Style Palettes 
for more information. 

When you click this command, the Manage Palettes dialog box appears: 

 
Title Bar 
The title bar shows the name of the style palette currently being edited. 

Style List 
The list box shows the list of the styles in the style palette. 

Each style in the palette has a name, type and properties that depend on the style type. If the style 
is a solid color style or a translucent color style, the CMYK values of the color are shown in the 
list. 

New Style 

Adds a new style to the style palette. 

Edit Style 

Edits the definition of the selected style in the style palette. This allows you to change the name, 
type and other properties of the style. 

Remove Style 

Removes the selected style from the style palette. 

New Palette 

Creates a new empty palette. 
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Open Palette 

Opens an existing style palette. 

Save Palette As 

Saves the current style palette with a new name. 

OK 

Saves the style palette and closes the Manage Palettes dialog box. 

Cancel 
Discards the changes made to the style palette and closes the Manage Palettes dialog box. 

Print Palette 

Creates an MCL drawing that shows the styles of the current style palette. You can print the 
produced MCL file as any other M-Color drawing, and use the printed style palette as a reference 
when choosing colors. 
 

Define Style Dialog Box 

 
Style name 

The name of the style you are editing. 

Save style in palette 

If checked, the style you are editing will be saved into the specified palette when you click OK. 

Style definition 

Defines the style type and the type-dependent properties. Select the style type you want and click 
the Edit button next to the style type name to modify the style definition. 

Style preview 

Displays the style using its current definition. 

OK 

Saves the style definition and closes the Define Style dialog box. 
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Cancel 
Discards the changes to the style definition and closes the Define Style dialog box. 
 

Define Color Dialog Box 

When you click the Edit button in the Define Style dialog box for a solid color style or a 
translucent color style or edit the starting and ending colors of a gradient style, the Define Color 
dialog box appears: 

 
Color mode 

Select CMYK, RGB or HSB. 

In CMYK mode, you can define colors by typing the Cyan, Magenta, Yellow and Black 
component percentages. The accepted range for CMYK values is from 0 to 100. 

In RGB mode, you can define colors by typing the amounts of the Red, Green and Blue 
components. The accepted range for RGB values is from 0 to 255. 

In HSB mode, you can define colors by typing the amounts of the Hue, Saturation and Brightness 
components. The accepted range for H is from 0 to 360 and for the other components from 0 to 
100. 

Color map 

The large square colored area in the dialog box shows the current main color tone and all the tones 
from the main tone to white and black. The little square cursor on the color map indicates the 
current color. To adjust the main tone, use the color tone slider on the right side of the color map. 
To fine-tune the color, move the square cursor on the color map. When the color mode is either 
RGB or HSB and Hide RGB and HSB colors that cannot be printed is selected, the red area 
demonstrates the color values most likely impossible for the printer to produce. When the color 
mode is CMYK, these color values are not displayed in the color map for selection because, by 
definition, all CMYK colors are likely to be printable with CMYK printers. 
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Color tone slider 
You can use the color tone slider to adjust the main color tone. The color map changes when you 
move the current position in the color tone slider. You should first select the main color tone using 
the color tone slider and then pick the desired color tone by clicking the color map on the left side 
of the color tone slider. 

Reference 

Allows you to compare the appearance of the old and new color definitions. The old definition is 
the one that was in use when you entered the Define Color dialog box. 

Components 

Allows you to specify the CMYK, RGB or HSB component values of the color. 

Transparency 

The transparency level of the color as a percentage. Displayed only if you are defining a 
translucent color style. Allowed values are from 0% to 100%. 0% means opaque (not transparent 
at all) and 100% means completely transparent (not visible, empty). 

Basic Colors 

Shortcuts for selecting basic colors such as black, white, red, green, blue, cyan, magenta and 
yellow.    

Select from Palette 

You may select a style from a palette to be used as a basis for the style being defined.  
  

Hide RGB and HSB colors that cannot be printed 

When using the RGB or HSB color modes, select Hide RGB and HSB colors that cannot be 
printed to see the gamut of a Generic CMYK Printer. If you have associated color profile(s) for the 
current printer, you may select the printer from the list to see the gamut of the device. This option 
helps you to avoid selecting colors that are impossible for printers to produce. Bright green is a 
good example of these colors.    

OK 

Saves the color definition and closes the Define Color dialog box. 

Cancel 
Discards the changes to the color definition and closes the Define Color dialog box. 
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Gradient Style Dialog Box 

When you click the Edit button in the Define Style dialog box for a gradient style, the Gradient 
Style dialog box appears: 

 
Mode 

Defines the form of the gradient: Linear, Radial or Adaptive. 

Angle 

Defines the direction of a linear gradient. 

Edge pad 

Defines the percentage of the gradient area that is filled with the starting color before the color 
begins to change towards the ending color. In linear mode, the same percentage of the gradient 
area on the other end of the gradient is filled with the ending color. 

Adaptive Gradient Options 

Defines the options for adaptive gradient style. Selecting Outside of object results in drawing the 
gradient fill outside the object's borders. 

Selecting Fit to object adjusts the adaptive gradient so that the From color appears at the outer 
edges of the object being filled, and the To color appears only at the innermost points of the object. 
You can use the Edge pad setting to increase the amount of the To color in the inner areas of the 
object. 

Selecting Constant width lets you define the absolute width of the gradient part of the adaptive 
gradient fill. In this mode, the gradient part has the same width regardless of the size of the object. 
Any excess areas at the inside of the object are filled with the To color. 

From 

Defines the starting color. Click Edit to define the color. 

To 

Defines the ending color. Click Edit to define the color. 
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Switch 

Exchanges the To and From colors. 

OK 

Saves the style definition and closes the Gradient Style dialog box. 

Cancel 
Discards the changes to the style definition and closes the Gradient Style dialog box. 

 You can adjust the transparency of the gradient style by setting the transparencies to start 
and end colors. 
 

Bitmap Texture Style Dialog Box 

When you click the Edit button in the Define Style dialog box for a bitmap texture style, the 
Bitmap Texture Style dialog box appears: 

 
Pattern layout 
Select Repeating tiles to define a texture in which the same bitmap image is repeated as many 
times as needed to fill the area. 

Select Stretched to fit to define a texture in which a single instance of the bitmap is used. The 
bitmap is stretched to fit the entire area that needs to be filled. 

Width 

Defines the width of the tile on paper when using the Repeating tiles layout mode. 

Height 
Defines the height of the tile on paper when using the Repeating tiles layout mode. 

Maintain original aspect ratio 

When checked, the width and height are automatically adjusted so that the original width-to-height 
ratio of the bitmap is preserved. You should generally leave this option on. 

Transparency 

Modifies the transparency of the bitmap. 
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Edit 
Edit the options of the bitmap like contrast, brightness etc. See Edit Bitmap Dialog Box for more 
information. 

Import 
Loads a bitmap and uses it as the pattern. 

Export 
Saves the bitmap to an external file that you can modify in photo-editing applications, for example. 

Size 

Shows the amount of memory the currently loaded pattern bitmap takes. In general, the memory 
size of the pattern bitmap should not exceed 500 kB. If you use larger bitmaps, the display and 
printing performance may degrade. 

OK 

Saves the style definition and closes the Bitmap Texture Style dialog box. 

Cancel 
Discards the changes to the style definition and closes the Bitmap Texture Style dialog box. 
 

Edit Bitmap Dialog Box 

When you click the Edit button in the Bitmap Texture Style dialog box, the Edti Bitmap dialog 
box appears: 

 
Intensity 

Modifies the intensity of the bitmap. 

Contrast 
Modifies the contrast between the pixels of the bitmap. When the contrast is set to 0, there is no 
contrast between pixels and the color of all pixels is gray. When the contrast is set to 100, the 
bitmap contains only pixels with pure colors like black, white, red, green blue, cyan etc. 
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Change Tone 

Changes the color tone of the bitmap. Select the target color by clicking Pick. The Select Hue 
Color dialog appears: 

 
Use the color slider to select the target color or select the color from Basic colors. Note that the 
calculating of the tone values for each pixel of the bitmap is a mathematically logical operation 
and before the tone level reaches the value of 100, you may also see tones of other colors than the 
target color in the bitmap. 

Saturation 

Modifies the color saturation of the bitmap. When the saturation is set to 0, the bitmap is fully 
grayscale. When set to 100, the colors of the bitmap are fully saturated. 

Brightness 

Controls the brightness of the bitmap between pure black and pure white. 
 

Tools / Create MPolygon Command 
Use this command to convert one or more closed LWPOLYLINE, POLYLINE or CIRCLE objects 
into an MPOLYGON object. 

MPolygons can consist of multiple boundaries. Boundaries that are completely inside other 
boundaries are treated as holes (islands). MPolygons are very useful in representing complex areas 
that you want to fill with M-Color because they support the concept of holes (islands). A standard 
LWPOLYLINE or POLYLINE object cannot contain holes. 

When you click this command, M-Color prompts you to select one or more objects. These objects 
will be converted into a single MPolygon object. 
 

Tools / Edit MPolygon Command 
Use this command to modify an MPolygon object. You can add new outer or inner boundaries to 
the MPolygon, move existing boundaries, or delete boundaries. 

Add 

The Add command lets you add new boundaries to the MPolygon. You can select one or more 
closed LWPOLYLINE, POLYLINE or CIRCLE objects. The objects you select will be added to 
the MPolygon. 

Delete 

The Delete command lets you remove a boundary from the MPolygon objects. 



 

 Chapter 5    COMMAND REFERENCE 97 
  

Move 

The Move command lets you move an existing boundary inside the MPolygon. You cannot move 
a boundary to a position where it crosses any other boundary of the same MPolygon. 

Rebalance 

The Rebalance command recalculates the internal relationships of the boundaries of the 
MPolygon. Using the Rebalance command is usually not necessary. If your MPolygon object is 
not filled correctly in M-Color plotting, use the Rebalance command to correct the internal 
structure of the MPolygon object. 
 

Tools / Import AutoCAD Color Book Command 
Use this command to convert an AutoCAD Color Book (.acb file) into an M-Color Style Palette 
(.pal file). 

AutoCAD 2004 and later include several color books such as the RAL color books. Other 
manufacturers will probably also make their color books available in the AutoCAD Color Book 
format (as an .acb file). You can use the Import AutoCAD Color Book command in M-Color to 
convert the .acb files into M-Color Style Palettes so that you can use these color books in M-Color. 
 

Settings Command 
Use this command to modify settings that are common to all drawings. 

When you click this command, the Settings dialog box appears. Click the appropriate tab to 
modify General, Format, Directories or Scale Correction settings. 
 

General Settings 

When you click the General tab in the Settings dialog box, the following property page is 
displayed: 
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Do not prompt for file name 

If enabled, M-Color does not ask for the plot file name but always uses the file name of the 
AutoCAD drawing, with the appropriate extension (.mcl, .pdf or .ps). 

Automatically launch preview 

If enabled, M-Color starts the preview application automatically after producing the previewable 
plot file, and opens the drawing in the preview. 

Enable incremental plotting 

If enabled, M-Color processes only those parts of the drawing that have changed since the last time 
you plotted the drawing (within this drawing session). Incremental plotting can dramatically 
reduce processing times during plotting. Disable this option only if you are experiencing problems 
you suspect could be related to incremental plotting. 

Incremental plotting takes place only when the MCL file format is being used. 

Fill arcs 

If enabled, M-Color fills AutoCAD's ARC objects if they are on a layer that has a fill style other 
than None. ARCs are closed by drawing a straight line segment from the start point of the arc to its 
end point. 

Fill open polylines 

If enabled, M-Color fills open polyline objects if they are on a layer that has a fill style other than 
None. Polylines are closed by drawing a straight line segment from the start point of the polyline 
to its end point. 

Auto-close polylines having equal start and end points 

If enabled, M-Color treats polylines whose start and end points are equal as closed polylines. Such 
polylines are filled also if the Fill open polylines option is off. 

Ignore AutoCAD line weights 

If enabled, M-Color ignores the line weights set to objects or layers in AutoCAD 2000 and later 
versions. In this case, only the line widths specified in the Plot Appearance (CFG) dialog box have 
effect. If the option is turned off, any line weights set in AutoCAD override the line widths 
specified in the CFG file. You should generally leave this option on to make defining line widths 
easier. 
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Format Settings 

When you click the Format tab in the Settings dialog box, the following property page is 
displayed: 

 
Output Format 
Sets the format of the plot file produced using the Preview and Plot command. One of the 
following: 

 MCL The file format of M-Color Preview. The default file format in M-Color. 
 PDF Portable Document Format. The file format of Adobe Acrobat applications. 
 PS PostScript. A commonly used page description language. 

 The recommended way of producing PDF and PostScript files is to first produce an MCL 
file and then use the Publish to PDF or Publish to PostScript command in M-Color Preview. This 
allows you to control various PDF and PostScript options. 
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Directories Settings 

When you click the Directories tab in the Settings dialog box, the following property page is 
displayed: 

 
File type 

Specifies the type of files for which the properties are being defined. 

Default Directory 

Specifies the default location of the defined file type. Click Browse to visually select a directory. 

Default File 

Specifies the default file used for the defined file type. Only available for CFG and PAL files (only 
meaningful for PAL files when using drawings created with versions 5.x or older of M-Color). 
Click Browse to visually select a file. 
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Scale Correction Settings 

When you click the Scale Correction tab in the Settings dialog box, the following property page is 
displayed: 

 
Using the scale correction setting allows you to correct small errors and material distortions that 
your plotter produces. The setting should not be used for big corrections or for changing the plot 
scale. 

Measured X length on paper 
Specifies the length of an horizontal line you have measured from the plot on paper. 

Desired X length on paper 
Specifies the length the horizontal line should have on paper. 

Measured Y length on paper 
Specifies the length of a vertical line you have measured from the plot on paper. 

Desired Y length on paper 
Specifies the length the vertical line should have on paper. 

Reset 
Resets the scale correction values to their defaults (100, 100, 100, 100). The default values do not 
cause any scale correction to be applied when plotting. 
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Edit Font Mappings Command 
Use this command to control the font mappings from the SHX fonts of AutoCAD to TrueType or 
Type 1 fonts used in M-Color. 

Click on the Font Mappings tab to see the current font mappings: 

 
The font mappings list displays all the current mappings made between SHX and TrueType / Type 
1 fonts. The Font in AutoCAD column of the list displays the AutoCAD font. The Font in M-Color 
column displays the corresponding font used by M-Color. The Width Adjustment column is 
selected if the exact width of the text in AutoCAD is preserved in M-Color. If the Width 
Adjustment column is not selected, the natural length of the font is used in M-Color. 

Change Font in M-Color 
Change the selected mapping's font in M-Color. 

Toggle Width Adjustment 
Change the width setting of the font mapping. 

Add AutoCAD Font 
Add a new font mapping for an SHX font. After clicking, define the full path to the SHX file (for 
example, C:\Program Files\AutoCAD 2004\Fonts\isocp.shx). 

Delete 

Remove a font mapping from the list. If there is no mapping for an SHX font, it is drawn as 
graphics in M-Color and so it looks exactly the same in M-Color as in AutoCAD. 
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Reset to Defaults 

Reset the mappings to the M-Color default font mapping values. All custom changes are lost. 

Select the Fonts in Current Drawing tab to see the font mappings affecting the active drawing: 

 
The AutoCAD Style column displays the used style in the active drawing. The other columns 
show the corresponding font mapping taking place in M-Color. 

OK 

Save changes and exit. 

Cancel 
Discard changes and exit. 

Help 

Open M-Color Help. 
 

M-Color Help Command 
Use this command to view M-Color Help. 
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About M-Color Command 
Use this command to view information about the current M-Color version. 

When you click this command, the following dialog box appears: 

 
Version 

The version number of M-Color is displayed at the bottom left corner of the dialog box. 

Serial Number 
The serial number that identifies the license you are using. The serial number is displayed only if 
you are using a single computer license, or if you are using a network license and are accessing 
this command on the license server computer. The serial number is not displayed on client 
computers that are accessing a network license. The serial number that is displayed is the serial 
number you entered when filling in the License Code Request. If you want to verify your serial 
number or license information, please contact your M-Color reseller or Motive Systems. 

License Status 

Displays status information about currently installed M-Color licenses. See License Status for 
more information. 

OK 

Closes the dialog box. 
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License Status 

When you click the License Status button in the About M-Color dialog box, the following dialog 
box appears: 

 
Active license server 
The host name of the computer functioning as the M-Color License Server. The license server 
manages M-Color licenses on the network. 

Software 

Indicates the M-Color version you are running (e.g. MCP90 means M-Color 9.0). 

License mode 

One of the following: 

 Single computer license 
 Network license 

Max concurrent users 

The number of users who can use M-Color concurrently. Depends on the size of the network 
license you have purchased. 

Licenses in use 

Indicates how many M-Color licenses are currently in use and how many are still available. 

License expiration date 

Indicates the date when this license will expire and stop functioning. If your license is not time-
limited, License will never expire is displayed. 

Current users of this license 

Displays information about each user who is currently using this M-Color license on the network. 
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User name 

The user name (user ID) of the user. 

Host name 

The host name of the computer the user is running M-Color on. 

Running since 

The date and time at which the user began using the license. 
 

File menu commands 
The File menu offers the following commands: 

Open Opens an existing document. 

Close Closes an opened document. 

Save Saves the current document using the same file name. 

Save As Saves the current document to a specified file name. 

Export to Bitmap Saves the document to a bitmap file format (such as TIFF, JPEG or GIF). 

Publish to PDF Saves the document to Adobe Acrobat's Portable Document Format 
(PDF). 

Publish to PostScript Saves the document to PostScript format. 

Page Setup Modifies a document's positioning and size when printed. 

Print Prints the document. 

Print Setup Manages print setup of the document. 

Scheduled Printing Manages scheduled printing of the documents. 

Color Management Modifies the color management options of the application. 

Document Security Allows you to modify the protection of the MCL document. 

License Management Allows you to perform tasks related to license management. 

Send Sends the active document through electronic mail. 

Exit Exits M-Color Preview. 
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Open command 
Use this command to open an existing document in a new window.  You can open multiple 
documents at once.  Use the Window menu to switch among the multiple open documents.  See 
Window 1, 2, ... command. 

Shortcuts 

 Toolbar:  

 Keys: CTRL+O 
 

Close command 
Use this command to close all windows containing the active document.  M-Color Preview 
suggests that you save changes to your document before you close it.  If you close a document 
without saving, you lose all changes made since the last time you saved it. 

You can also close a document by using the Close icon on the document's window, as shown 
below: 

 
 

Save command 
Use this command to save the active document to its current name and directory.  If you want to 
change the name and directory of an existing document before you save it, choose the Save As 
command. 

Shortcuts 

 Toolbar:  

 Keys: CTRL+S 
 

Save As command 
Use this command to save and name the active document.  M-Color Preview displays the Save As 
dialog box so you can name your document.  

To save a document with its existing name and directory, use the Save command. 
 



 

108 M-Color 9 User's Guide 
 

Save Copy As command 
This command is only available when you are editing an M-Color document that is currently 
embedded in another application's document. 

Use this command to save and name a copy of the document being edited.  M-Color Preview 
displays the Save As dialog box so you can name your document. 
 

Update command 
This command is only available when you are editing an M-Color document that is currently 
embedded or linked in another application's document. 

Use this command to update the current document in the container application's document. 
 

Export to Bitmap command 
Use this command to export the active document to a bitmap file format such as TIFF, JPEG or 
GIF. 

When you click this command, M-Color Preview asks you to specify the file name and the file 
format. 

After specifying the file name and file format, the Export - Format Options dialog box is 
displayed: 

 
Compression 

The internal compression format used in this file format. If available, use LZW for color and 
grayscale images, and CCITT Group 4 for monochrome images. 

Color depth 

Specifies the color depth (number of colors) for the output file. 
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Color space 

Specifies the color space. Select RGB (current display colors) to set the bitmap color values as 
displayed currently on screen. Select Standard RGB to store the bitmap color values in a 
standardized color format. See Colors in Bitmap Exporting for more information. 

Size 

Select 1 to 1 to automatically adjust the width and height values according to the resolution setting 
and the real dimensions of the drawing. 

Select Custom to manually adjust the width and height values. 

Width x Height 
The width and height of the output file in pixels. Aspect ratio is automatically maintained, so 
changing one value will affect the other. 

Resolution 

The density of the output file. 

Uncompressed image size 

The size of the output file if it were created using the current settings and no internal file 
compression. The real file size is usually much smaller, but this value gives a good estimate of the 
memory requirements of the target file when it is edited in other applications. 

Image dimensions 

The natural dimensions of the output file, as calculated from the pixel width and height and the 
resolution value. 

OK 

Accepts the settings and produces the output file. 

Cancel 
Cancels the export operation. 

Reset 
Resets the settings to their default values. 
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Publish to PDF 
Use this command to save the active document to Adobe's Portable Document Format (PDF). 

When you click this command, the PDF Options dialog box is displayed: 

 
Compatibility 

Specifies the oldest Acrobat version that the produced PDF file should be compatible with. If you 
select Acrobat 5.0 (PDF 1.4), M-Color will use PDF features that are supported only by Acrobat 
5.0, and you may not be able to view the PDF file in Acrobat 4.0, for example. Using the Acrobat 
5.0 (PDF 1.4) format or later is recommended because it offers better performance with translucent 
fills. 

Document Info 

Allows you to specify document information for the PDF file. Document information includes 
title, subject, author and keywords for the document. You can tell M-Color to prompt for 
document info each time a PDF file is created, or to use the specified default values. 

Compress text and line art 
When this option is enabled, M-Color compresses the text and line art portions of the PDF file. 
This results in a smaller PDF file. 

Reduce file size by using binary data 

When this option is enabled, M-Color uses binary data to generate PDF file. This results in a 
smaller PDF file binary. 
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Use native PDF gradients 

When this option is enabled, M-Color uses the gradient pattern features of the PDF file format to 
describe gradient fills. This makes the PDF files smaller and improves performance. 

Use native PDF transparency 

When this option is enabled, M-Color uses the transparency support of the PDF file format when 
drawing translucent fills. This makes the PDF files smaller and improves performance. 

This option is only available when producing PDF files for Acrobat 5.0 or newer. 

Include hyperlinks 

When this option is enabled, M-Color writes hyperlinks specified in AutoCAD drawing as links in 
the PDF file. 
View PDF after creation 

When this option is enabled, M-Color will automatically open the created PDF file in Adobe 
Acrobat. 

Colors 

Specifies the color mode of the PDF file. Select Standard RGB to store the color values in a 
standardized mode (default). Select RGB (Current display colors) if you target to those color 
values currently displayed on screen. Select CMYK (Generic CMYK printer) to create a PDF with 
colors simulated through the Generic CMYK Printer of M-Color. Select RGB (Current printer) if 
you wish to include the colors simulated through the current printer of the document. This option 
requires that you have a color profile active with the active document's printer. See Colors in PDF 
and PostScript Formats for more information. 

Embed all fonts 

When this option is enabled, M-Color writes the definitions of all used fonts to the PDF file. This 
enables viewing the PDF file with correct fonts even if the target system does not have the same 
fonts installed. 

Turning this option off reduces the size of the produced PDF file. 

Subset embedded fonts 

When this option is enabled, M-Color writes the definitions of only the needed characters of each 
embedded font. This makes the PDF files smaller. 

Bitmap Downsampling / Monochrome Images 

Defines the maximum resolution of monochrome bitmaps in the PDF file. Any bitmaps that use a 
higher resolution will be reduced to this specified resolution during the creation of the PDF file. 

Bitmap Downsampling and compression of color Images 

Defines the maximum resolution of grayscale and color bitmaps in the PDF file. Any bitmaps that 
use a higher resolution will be reduced to this specified resolution during the creation of the PDF 
file. 
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Compression method defines the compression algorithm used for grayscale and color images. The 
default setting, JPEG, usually results in the smallest PDF file. However, because the JPEG 
algorithm is lossy, the quality of color bitmaps may not be exactly as good as with the Flate and 
LZW algorithms which are lossless. 

Downsampling and compression of rasterized effects 
Defines the maximum resolution of rasterized effects in the PDF file. Also set the compression 
algorithm used for rasterized effects in the PDF file. Rasterized effects include drop shadows and 
adaptive gradient fills. 
Continue 

Saves the settings, closes the dialog box and prompts for the PDF file name. 

Cancel 
Closes the dialog box without saving the settings and without producing a PDF file. 

Close 

Saves the settings and closes the dialog box but does not produce a PDF file. 

Defaults 

Restores the default settings. 
 

Publish to PostScript 
Use this command to save the active document to PostScript format. 

When you click this command, the PostScript Options dialog box is displayed: 

 
Mode 

Select the output mode to be either PS or EPS. 

Compatibility 

Specifies the oldest PostScript language level that the produced PS file should be compatible with. 
If you select PostScript Level 3, M-Color will use PostScript features that are supported only by 
PostScript Level 3 or newer printers. If you know that the target device supports PostScript Level 
3, you should select PostScript Level 3 in M-Color because this will make the produced PostScript 
file smaller and more efficient to process. 
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Colors 

Specifies the color mode of the PS file. Select Standard RGB to store the color values in a 
standardized mode (default). Select RGB (Current display colors) if you target to those color 
values currently displayed on screen. Select CMYK (Generic CMYK printer) to create a PS with 
colors simulated through the Generic CMYK Printer of M-Color. Select RGB (Current printer) if 
you wish to include the colors simulated through the current printer of the document. This option 
requires that you have a color profile active with the active document's printer. See Colors in PDF 
and PostScript Formats for more information. 

Bitmap Downsampling / Monochrome Images 

Defines the maximum resolution of monochrome bitmaps in the PostScript file. Any bitmaps that 
use a higher resolution will be reduced to this specified resolution during the creation of the 
PostScript file. 

Bitmap Downsampling and compression of color Images 

Defines the maximum resolution of grayscale and color bitmaps in the PostScript file. Any 
bitmaps that use a higher resolution will be reduced to this specified resolution during the creation 
of the PostScript file. 

Compression method defines the compression algorithm used for grayscale and color images. The 
default setting, JPEG, usually results in the smallest PostScript file. However, because the JPEG 
algorithm is lossy, the quality of color bitmaps may not be exactly as good as with the Flate and 
LZW algorithms which are lossless. 

Downsampling and compression of rasterized effects 
Defines the maximum resolution of rasterized effects in the PostScript file. Also set the 
compression algorithm used for rasterized effects in the PostScript file. Rasterized effects include 
drop shadows and adaptive gradient fills. 
Continue 

Saves the settings, closes the dialog box and prompts for the PS file name. 

Cancel 
Closes the dialog box without saving the settings and without producing a PS file. 

Close 

Saves the settings and closes the dialog box but does not produce a PS file. 

Defaults 

Restores the default settings. 
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Page Setup command 
Use this command to control the positioning and size of the M-Color drawing on the destination 
printer's page. See Viewing the Drawing's Layout on the Printer's Page for more information. 

When you click this command, the Page Setup dialog box appears: 

 
Left 
The offset of the M-Color plot from the left border of the printer's page. A negative value moves 
the M-Color plot to the left on the printer's page and a positive value moves the M-Color plot to 
the right on the printer's page. 

Top 

The offset of the M-Color plot from the top border of the printer's page. A negative value moves 
the M-Color plot upwards on the printer's page and a positive value moves the M-Color plot 
downwards on the printer's page. 

Scale 

The scale of the M-Color plot when printed. 100% specifies no scaling. 

Center on Page 

Positions the M-Color plot at the center of the printer's page. 

Fit to Page 

Scales and positions the M-Color plot so that it completely fits inside the printable area of the 
printer's page. 

Reset 
Resets the settings to their basic values. 

Defaults 

Sets the values to reasonable defaults, considering the page's orientation and size. 
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Move MCL 

Visually position the MCL document in reference to the printer paper. 

Move Printer Paper 
Visually position the printer paper in reference to the MCL document. 

Fit Area to Printer Paper 
Fit an area of the MCL document to the printer paper. Lock the first corner of the area by clicking 
the left mouse button, hold it down and drag the mouse until the area is complete. 

Rotation 

Rotates the MCL document on the printer page. 

OK 

Accepts the settings and closes the dialog box. 

Cancel 
Discards the settings and closes the dialog box. 

Apply 

Applies the current settings to the active document but does not close the Page Setup dialog box. 
 

Print command 

 
Use this command to print a document. This command presents a Print Options dialog box, where 
you may specify the destination printer and other printer setup options. 

Shortcuts 

 Toolbar:  

 Keys:  CTRL+P 
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Print as bitmap 
Try this option if you have problems with printing. With this option enabled, M-Color will 
produce a bitmap for the printer. 

Rasterized effects 
Set the resolution of rasterized effects. 

Print text as graphics 
Try this option if you have problems with printing text. With this option enabled, M-Color will 
print text layers as graphics. 
 

Print Setup command 
Use this command to select a printer and a printer connection. This command presents a Print 
Setup dialog box, where you specify the printer and the page size. 

Shortcuts 

 Toolbar:  
 

Scheduled Printing command 
Use this command to manage scheduled printing settings. 

 
Document 
Choose the MCL document to be printed at given time. 

Target 
Set the MCL document to be printed to a printer, PDF file, PS file or exported as bitmap. 
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Print to file 

With this option you can generate printer plot files. Choose the filename. 

Number of copies 

Defines the number of copies to be printed. 

Start Time 

Defines the starting moment of the scheduled printing. 

Jobs 

The Document column displays the MCL file to be printed. The Location column displays the 
folder of the MCL file. The Target column displays the target used to perform the printing. The 
Output File column displays the plot file name if printing to file and the copies column shows the 
amount of copies to be printed. 

Add to Jobs 

Adds the active MCL document to the scheduled print job using the current page and print setup 
information. 

Remove Job 

Removes the selected job from the scheduled printing task. 

OK 

Save changes and exit. 

Cancel 
Discard changes and exit. 

 The used printer and page layout are stored within the print job when OK is clicked. This 
means that the changes made to these settings of the MCL document later on have no effect when 
the scheduled printing is set processed. 
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Color Management command 
Use this command to view and edit the color management settings of M-Color. For more 
information on the principles of color management, see Using M-Color / Color Management. 

When you click the Color Management command on the File menu in M-Color Preview, the Color 
Management dialog box appears: 

 
Enable color management 
When this option is on, M-Color uses ICC color profiles to compensate for device-specific 
differences when displaying or printing colors. Turn this option off only if you want to revert to 
the old, static color system that was used in M-Color 7.x and older versions. 

Display simulated printer colors 

Turn this option on if you want M-Color to simulate the colors of your printer in screen display. 
This option has a visible effect only if your drawing contains colors that can be displayed on your 
monitor but cannot be produced with printer technology (such as bright green). When simulating 
printer colors, M-Color replaces non-printable colors with their closest printable equivalents. 
Typically, this makes bright colors darker and decreases the overall saturation of colors. 

Simulate generic inkjet printer 
In this mode, the simulation of printer colors on screen is based on the characteristics of a generic 
CMYK inkjet printer. Using this simulation mode is useful if you do not have an ICC color profile 
that would allow you to simulate the actual printer that you intend to use. 
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Simulate current printer 
In this mode, the simulation of printer colors on screen is based on the active ICC color profile of 
the current printer. Note that each MCL document may have a different current printer. Use the 
Print Setup command to change the current printer of the active MCL document. 

M-Color uses the information in the ICC color profile to display colors on screen as they would 
appear if printed with the current printer. The accuracy of the simulation depends on the accuracy 
of the color profile. Simulating the colors of the current printer is possible only if it has an ICC 
color profile. For best results, you also need to have a calibrated monitor. 

Color profiles / Display 

The list of color profiles associated with your monitor. The active color profile is marked with the 
word Active in the Status column. 

If the None profile is active, M-Color sends sRGB color values to your monitor without making 
any device-specific adjustments to them. In this case, the accuracy of colors depends on how 
closely your monitor matches the “standard monitor” assumed by the sRGB color system. See 
Monitor Calibration for more information. 

Color profiles / Printing 

The list of color profiles associated with the selected printer. The active color profile is marked 
with the word Active in the Status column. 

If the None profile is active, M-Color sends sRGB color values to this printer without making any 
device-specific adjustments to them. In this case, the accuracy of printed colors depends on how 
well the color output of the printer matches the sRGB color system. If your printer is advertised as 
an sRGB printer, the color accuracy should be fairly good with the None profile. If not, you should 
obtain a custom ICC color profile for the printer so that M-Color knows how to compensate for 
device-specific color differences. See Printer Calibration for more information. 

Add 

Add a color profile for your monitor or for the currently selected printer. 

If you do not yet have an ICC color profile for your device, see Monitor Calibration and Printer 
Calibration for more information. 

Remove 

Remove the selected color profile. 

Make Active 

Activate the selected color profile. Only the active color profile of a device affects the color output 
of M-Color. 

Color Profiles Online 

Displays a web page with additional instructions and tips on color management issues in M-Color. 

Close 

Closes the dialog and saves changes. 
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Document Security command 
Use this command to define the protection of the MCL document. 

 
Define Password 

Select Protect this MCL document to enable protection. Define the required password for 
accessing the protected operations. 

Protected Operations 

Select the protected operations: 

 Opening the document. 
 Printing and exporting (including PDF, PS, raster formats, copy to clipboard). 
 Accessing the Plot Appearance configuration file (CFG) of the document. 

OK 

Apply changes and exit. 

Cancel 
Discard changes and exit. 

 The MCL file must be saved before the defined security settings take effect. 
 

License Management 
The commands on the License Management menu allow you to activate your license, view license 
status information and request a license code. 
 

Send command 
Use this command to send the active document through electronic mail.  This command presents a 
mail window with the active document attached to it. You may then fill out the To: field, Subject: 
field, etc., and add text to the body of the message if you wish.  When you are finished you may 
click the "Send" button to send the message. 
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1, 2, 3, 4 command 
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.  Choose the number that corresponds with the document you want to open. 
 

Exit command 
Use this command to end your M-Color Preview session. You can also use the Close command on 
the application Control menu.  M-Color Preview prompts you to save documents with unsaved 
changes. 

Shortcuts 

 Mouse: Double-click the application's Control menu button. 

   
 Keys: ALT+F4 
 

Edit menu commands 
The Edit menu offers the following commands: 

Copy to Clipboard Copies the document to the clipboard. 

Plot Appearance (CFG) Modifies the fill style, outline style and line width settings of this 
drawing. 

Manage Palettes Modifies style palettes, allowing addition of new styles or modification 
of existing ones. 

Raster Images Modifies the raster images in the document. 

Expert Settings Modifies advanced settings of M-Color Preview (recommended for 
experienced users only). 

 

Copy to Clipboard command 
Use this command to copy the active document onto the clipboard. 

Copying data to the clipboard replaces the contents previously stored there. 

Shortcuts 

 Toolbar:  

 Keys: CTRL+C 
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Raster Images command 
Use this command to view information about the raster images in the document. See Working 
with Raster Images for more information. 

When you click this command, the Raster Images dialog box appears: 

 
Raster Images in the Drawing 

Lists the index numbers and file names of the raster images in this document. 

Inverted (monochrome images only) 
Inverts (negates) the selected image. Works only for monochrome (1-bit, black and white) raster 
images. 

White pixels transparency on (color images only) 
Makes the white pixels (RGB 255, 255, 255) of a raster image transparent. Works only for 
grayscale and color raster images. 

Width and Height 
The selected image's width and height in pixels. 

Bit depth 

The color depth of the selected image. 1 means a monochrome (black and white) image, other 
values mean a color or a grayscale image. 

Rotation 

The selected raster image's rotation in the current drawing in degrees (counterclockwise). 

Size 

The size of the image in system memory. 
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Expert Settings command 
Use this command to modify advanced settings of M-Color Preview. Using this command is 
recommended only for advanced users. 

When you click this command, the Expert Settings dialog box appears: 

 
Show printing time report after printing 

If enabled, a printing time report is displayed after printing. 
Show tooltips 

If enabled, tooltips are shown in the Plot Appearance dialog. 
Enable undo in Plot Appearance 

If enabled, the undo and redo operations are enabled in the Plot Appearance dialog. Sometimes 
this operation may consume a lot of memory so it can be disabled if necessary. 
Save print setup with document 
If enabled, M-Color Preview saves the printer selection, printer settings and page setup settings 
into the MCL file. This allows M-Color to use the same settings when you open the file again 
later. 

Units 

The default units used in the application. 

Flat line ends 

If enabled, M-Color Preview uses flat line ends as the line cap style when drawing lines. If 
disabled, round line ends will be used. 
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Ignore overlapping translucency within a single layer 
If enabled, overlapping translucent areas on a single layer are combined instead of affecting one 
another. Reduces the processing time of the plot if overlapping translucent areas exist. 

Enable text length correction 

Turning on this option may help some printer drivers process the text data in the M-Color drawing 
more easily. 

Display large images 

Enables or disables the drawing of heavy raster images on screen. Does not affect printing. 

Optimize gradient fills with bitmaps 

If enabled, M-Color Preview uses bitmaps when appropriate to achieve optimal quality and 
performance when printing gradient styles. If you experience problems in printing gradient fills 
with your printer, you should try turning off this option. 
Always send jobs to spooler as RAW datatype 

If enabled, M-Color Preview always uses RAW data type (as opposed to EMF data type) when 
sending the printing jobs to the spooler. RAW data type is the safer setting but may sometimes 
slow down plotting. Disable this option to possibly improve plotting speed if you know that your 
printer driver can properly process print jobs using the EMF data type. 

Memory consumption limits / Cached raster images 

The cache size used by M-Color Preview. If the document contains large raster images, you may 
increase the cache size to speed up processing. 

Memory consumption limits / Rasterizing 

If the document contains large rasterized effects, you may increase the cache size to speed up 
processing. Rasterized effects include drop shadows and adaptive gradients. 

Defaults  

Resets the settings to their default values. 
 

Zoom menu commands 
The Zoom menu offers the following commands: 

Pan Moves the drawing display in the window. 

Zoom Window Magnifies the document in the preview. 

Zoom Previous Return to the previous zoom. 

Zoom to Width Fits the document to the current window so that its whole width is visible. 

Zoom to Fit Fits the document to the current window. 
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Pan command 
Use this command to move the drawing display in the window. See Zooming and Panning for 
more information. 
 

Zoom Window command 
Use this command to magnify the document being previewed. See Zooming and Panning for 
more information. 
 

Zoom Previous command 
Use this command to go back to the previous zoom level. See Zooming and Panning for more 
information. 
 

Zoom to Width command 
Use this command to zoom the document so that its width fits in the current window. See 
Zooming and Panning for more information. 
 

Zoom to Fit command 
Use this command to zoom the document so that it completely fits inside the current window. See 
Zooming and Panning for more information. 
 

View menu commands 
The View menu offers the following commands: 

Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

Zoom Bar Shows or hides the zoom bar. 

Print Space Turns the Print Space viewing mode on or off. Print Space mode shows the 
document's positioning on the currently selected printer's paper. 

 

Toolbar command 
Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in M-Color Preview, such as File Open.  A check mark appears next to the 
menu item when the Toolbar is displayed. 

See Toolbar for help on using the toolbar. 
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Toolbar 

 
The toolbar is displayed across the top of the application window, below the menu bar.  The 
toolbar provides quick mouse access to many tools used in M-Color Preview, 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

 Open an existing document. 

 Save the active document or template with its current name. 

 Copy the active document to clipboard. 

 Save the active document to bitmap format. 

 Save the active document to PDF format. 

 Modify page positioning and size when printed. 

 Print the active document. 

 Select the printer and paper size for printing documents. 

 Move the drawing display in the window. 

 Zoom in. 

 Zoom out. 

 Return to the previous zoom. 

 Zoom to document's width. 

 Fit the document in its current window. 
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 Modify the fill style, outline style and line width settings. 

 Modify style palettes. 

 Turn the Print Space viewing mode on or off. 

 Display information about the current M-Color version. 

 Display help about a command specified by pointing with the mouse. 
 

Status Bar command 
Use this command to display and hide the Status Bar, which describes the action to be executed by 
the selected menu item or depressed toolbar button, and keyboard latch state. A check mark 
appears next to the menu item when the Status Bar is displayed. 

See Status Bar for help on using the status bar. 
 

Zoom Bar 

 
Select this command to hide or display the Zoom Bar. The Zoom Bar displays the current zoom 
percentage. You may also enter the zoom level as a percentage. 
 

Status Bar 
 

The status bar is displayed at the bottom of the M-Color Preview window.  To display or hide the 
status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.  This area similarly shows messages that describe the actions of toolbar 
buttons as you depress them, before releasing them.  If after viewing the description of the toolbar 
button command you wish not to execute the command, then release the mouse button while the 
pointer is off the toolbar button. 

The three other fields at the right end of the status bar show the current selected printer, the 
printer's paper size and the size of the active document in M-Color Preview.  
 

Print Space command 
Use this command to turn on or off the M-Color Print Space viewing mode. M-Color Print Space 
allows you to see the current printer's page and margins on the preview screen and thus better 
control the final positioning and scaling of the plot. 

See Viewing the Drawing's Layout on the Printer's Page 
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Window menu commands 
The Window menu offers the following commands, which enable you to arrange multiple views of 
multiple documents in the application window: 

New Window Creates a new window that views the same document. 

Cascade Arranges windows in an overlapped fashion. 

Tile Horizontally Arranges windows in non-overlapped tiles. 

Tile Vertically Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of closed windows. 

Window 1, 2, ... Goes to specified window. 
 

New Window command 
Use this command to open a new window with the same contents as the active window.  You can 
open multiple document windows to display different parts or views of a document at the same 
time.  If you change the contents in one window, all other windows containing the same document 
reflect those changes.  When you open a new window, it becomes the active window and is 
displayed on top of all other open windows. 
 

Cascade command 
Use this command to arrange multiple opened windows in an overlapped fashion. 
 

Tile Horizontally command 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 
 

Tile Vertically command 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 
 

Arrange Icons command 
Use this command to arrange the icons for minimized windows at the bottom of the main window.  
If there is an open document window at the bottom of the main window, then some or all of the 
icons may not be visible because they will be underneath this document window. 
 

1, 2, ... command 
M-Color Preview displays a list of currently open document windows at the bottom of the Window 
menu.  A check mark appears in front of the document name of the active window.  Choose a 
document from this list to make its window active. 
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Help menu commands 
The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get help. 

Printing Tips Online Displays a web page that contains tips about achieving the best possible 
printing performance with M-Color. 

Color Profiles Online Displays a web page that contains help about color management issues. 

About M-Color Displays information about M-Color. 
 

Help Topics command 
Use this command to display the contents of on-line help. 
 

Printing Tips Online command 
Use this command to view tips for achieving the best possible printing performance with M-Color. 
 

Color Profiles Online command 
Use this command to view tips on color management issues when working with M-Color. 
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About M-Color Command 
Use this command to view information about the current M-Color version. 

When you click this command, the following dialog box appears: 

 
Version 

The version number of M-Color is displayed at the bottom left corner of the dialog box. 

Serial Number 
The serial number that identifies the license you are using. The serial number is displayed only if 
you are using a single computer license, or if you are using a network license and are accessing 
this command on the license server computer. The serial number is not displayed on client 
computers that are accessing a network license. The serial number that is displayed is the serial 
number you entered when filling in the License Code Request. If you want to verify your serial 
number or license information, please contact your M-Color reseller or Motive Systems. 

License Status 

Displays status information about currently installed M-Color licenses. See License Status for 
more information. 

OK 

Closes the dialog box. 
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See online help for information on programming M-Color. 
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Contacting Technical Support 
The latest Troubleshooting and FAQ information is available on the Internet. Please point your 
browser to http://www.m-color.com/ to contact M-Color Technical Support. 

Please provide a detailed description of the problem situation in your message. If possible, explain 
the problem so that our technical support staff can reproduce the problem. 

In general, you need to send the following files along with your message to help us understand the 
problem or question you are having. Send the files as attachments to the e-mail message: 

 DWG (the AutoCAD drawing) 
 MCL (the M-Color Preview file) 
 SHX fonts and shape files and TTF (TrueType) fonts 
 Possible raster images (e.g. TIF, RLC) 

The best way to ensure that all necessary files are included is to use the eTransmit tool of 
AutoCAD 2002 and later (Pack 'n Go in AutoCAD 2000 and AutoCAD R14). To start eTransmit 
in AutoCAD 2002 or 2004, click File / eTransmit. To start Pack 'n Go in AutoCAD 2000, click 
Express / Tools / Pack 'n Go. To start Pack 'n Go in AutoCAD R14, click Bonus / Tools / Pack 'n Go. 
These tools do not include the MCL file so you need to remember to add it yourself. 

Send your e-mail message to support@m-color.com. 
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